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SENSORS & SOFTWARE INC. PRODUCT LICENSE, COPYRIGHT, LIABILITY AND WARRANTY 

INFORMATION 

Important 

Please read this document carefully before using the SOFTWARE PRODUCT or assembling the HARDWARE 

PRODUCT. By using the storage media or assembling the hardware, you are agreeing to be bound by the 
terms of this agreement. If you do not agree to the terms of this agreement, promptly contact Sensors & 
Software, Inc. at the address indicated at the end of this document. 

Definition 

The word PRODUCT as used herein defines any item sold by Sensors & Software, Inc. and may be 
comprised of HARDWARE PRODUCT which consists of physical objects and SOFTWARE PRODUCT which 
means computer programs, codes and related support materials. 

Software Product License Agreement 

In order to preserve and protect its rights under the applicable laws, Sensors & Software, Inc. does not 
sell any rights to its Software products. Rather, Sensors & Software, Inc. I grant the right to use its 
software, CDs, memory sticks (or other storage media) and documentation (hereafter collectively called 
SOFTWARE PRODUCT) by means of a SOFTWARE PRODUCT license.  You acknowledge and agree that 
Sensors & Software, Inc. retains worldwide title and rights to all its software and that the SOFTWARE 

PRODUCT contains proprietary materials protected under copyright, trademark and trade secret laws. 

Grant of Software Product License 

In consideration of payment of the license fee which is the price you pay for the SOFTWARE PRODUCT and 
your agreement to abide by the terms and conditions of this License Agreement, Sensors & Software, 
Inc. grants to you, the Licensee, a non-exclusive right to use the SOFTWARE PRODUCT under the following 
conditions: 

You may: 

• use the SOFTWARE PRODUCT on a single workstation owned, leased or otherwise controlled by you; 

• copy the SOFTWARE PRODUCT for backup purposes in support of your use of the product on a single 
workstation. 

You may not: 

• copy, distribute or sell copies of the SOFTWARE PRODUCT or accompanying written materials, 
including modified or merged SOFTWARE PRODUCT to others; 

• sell, license, sublicense, assign or otherwise transfer this license to anyone without the prior written 
consent of Sensors & Software, Inc.; 

• modify, adapt, translate, decompile, disassemble or create derivative works based on the 
SOFTWARE PRODUCT. 

Termination 

This license is effective until terminated. You may terminate the license at any time by returning the 
SOFTWARE PRODUCT and all copies to Sensors & Software, Inc.  The license will automatically terminate 
without notice by Sensors & Software, Inc. if you fail to comply with any terms or conditions of this 



 

agreement.  Upon termination, you agree to return all copies of the SOFTWARE PRODUCT to Sensors & 
Software, Inc. 

Update Policy 

Sensors & Software, Inc. may create, from time to time, updated versions of its SOFTWARE PRODUCT.  At 
its option, Sensors & Software, Inc. will make such updates available to licensees who have paid the 
update fee. 

Product Warranty, Limited Remedy and Limited Liability  

Sensors & Software, Inc. warrants the PRODUCT to be free from defect in material and workmanship under 
normal use for a period of one year (365 days) from the date of shipment.  Any third-party computer 
systems or other items not manufactured directly by Sensors & Software, Inc. purchased with any 

PRODUCT or independently from Sensors & Software, Inc. are subject to the original manufacturer's 
warranty and are not the responsibility of Sensors & Software, Inc. 

Sensors & Software, Inc. makes no other warranties including, but not limited to, any implied warranty of 
merchantability or fitness for a particular purpose.  If this product is defective within the warranty period 
stated above, your exclusive remedy shall be, at Sensors & Software, Inc.’s option to replace or repair the 
Sensors & Software, Inc. product or refund the purchase price of the Sensors & Software, Inc. product.  
Except where prohibited by law, Sensors & Software, Inc. will not be liable for any loss or damage arising 
from this Sensors & Software, Inc. product, whether direct, indirect, special, incidental or consequential 
regardless of the legal theory asserted. 

All statements, technical information, and recommendations related to Sensors & Software, Inc. products 
are based on information believed to be reliable, but the accuracy or completeness is not guaranteed.  
Before using this product, you must evaluate it and determine if it is suitable for your intended application.  
You assume all risks and liability associated with such use.  Any statements related to the product, which 
are not contained in Sensors & Software, Inc. current publications, or any contrary statements contained 
on your purchase order shall have no force or effect unless expressly agreed upon, in writing, by an 
authorized officer of Sensors & Software, Inc. 

Sensors & Software, Inc. warrants the CD, memory stick or other storage media on which the SOFTWARE 
PRODUCT is furnished to be free from defects in material and workmanship under normal use for a period 
of ninety (90) days from the date of purchase as evidenced by a copy of your invoice. 

Except as specified above, any SOFTWARE PRODUCT is provided "as is" without warranty of any kind, either 
expressed or implied, including, but not limited to, the use or result of use of the product in terms of 
correctness, accuracy, reliability, currentness or otherwise. The entire risk as to the results and 
performance of the PRODUCT is assumed by you. If the PRODUCT is defective or used improperly, you, and 
not Sensors & Software, Inc. or its dealers, distributors, agents, or employees, assume the entire cost of 
all necessary servicing, repair or correction. 

Sensors & Software, Inc.'s entire liability and your exclusive remedy for SOFTWARE PRODUCT shall be, at 
Sensors & Software, Inc.'s option, either: 

• the replacement of any storage media (CD, memory stick etc.) or hardware components which do 
not meet Sensors & Software, Inc.'s Limited Warranty and which are returned to Sensors & 
Software, Inc. postage prepaid with a copy of the receipt, or 

• if Sensors & Software, Inc. is unable to deliver a replacement storage media which is free of 
defects in material or workmanship, Licensee may terminate this agreement and have the license 
fee refunded by returning all copies of the SOFTWARE PRODUCT postage prepaid with a copy of the 
receipt. 

 



 

If failure of any PRODUCT resulted from accident, abuse or misapplication, Sensors & Software, Inc. shall 
have no responsibility to replace the SOFTWARE PRODUCT, refund the license fee, or replace or repair the 
HARDWARE PRODUCT. 

Do not tamper with any PRODUCT.  PRODUCT contains no user serviceable parts.  If tampering is 
evident in Sensors & Software, Inc.’s opinion, warranty is void and null. 

No oral or written information or advice given by Sensors & Software, Inc., its dealers, 
distributors, agents or employees shall create a warranty or in any way increase the scope of this 
warranty and you may not rely on any such information or advice. 

Neither Sensors & Software, Inc. nor anyone else who has been involved in the creation, 
production or delivery of the PRODUCT shall be liable for any direct, indirect, special, exemplary, 
incidental or consequential damages, claims or actions including lost information, lost profits, or other 
damages arising out of the use or inability to use this PRODUCT even if Sensors & Software, Inc. has been 
advised of the possibility of such damages. 

This warranty gives you specific rights.  You may have other rights which vary from province to province, 
territory to territory and certain limitations contained in this limited warranty may not apply to you. 

General 

No right, license, or interest to any Sensors & Software, Inc. trademarks is granted hereunder with the 
purchase of the PRODUCT or the SOFTWARE PRODUCT license. 

Governing Law 

In the event of any conflict between any provision in this license agreement and limited warranty and any 
applicable provincial legislation, the applicable provincial legislation takes precedence over the 
contravening provision.  This agreement shall be governed and construed in accordance with the laws of 
the Province of Ontario, Canada. 

Serviceability 

Should any term of this agreement be declared void or not enforceable by any court of competent 
jurisdiction, the remaining terms shall remain in full effect. 

Waiver 

Failure of either party to enforce any of its rights in this agreement or take action against any other party 
in the event of a breach of this agreement shall not be considered a waiver of the right to subsequent 
enforcement of its rights or actions in the event of subsequent breaches by the other party. 

Acknowledgement 

You acknowledge that you have read this agreement, understand it and agree to be bound by its terms 
and conditions. You further agree that this agreement is the complete and exclusive statement of 
agreement between the parties and supersedes all proposals or prior agreements oral or written between 
the parties relating to the subject matter of this agreement. 

Should you have any questions concerning this agreement, please contact in writing: 

 

 

 



 

Sensors & Software Inc. 

1040 Stacey Court 

Mississauga, Ontario 

Canada L4W 2X8 

Tel:(905) 624-8909 

Toll Free: 1-800-267-6013 

Fax:(905) 624-9365 

E-mail: customerservice@sensoft.ca 

Sensors & Software, Inc. trademarks are listed at: www.sensoft.ca/trademarks 

1999-00236-04 
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1 Getting Started 

The Sensors & Software Inc. IceMap system uses Ground Penetrating Radar (GPR) technology 
to measure the thickness of ice. The GPR sensor used in IceMap is typically a Noggin 500 
system, but a Noggin 250 or Noggin 1000 could also be used. 

As IceMap is towed across the ice surface, as shown in Figure 1-1 and Figure 1-2, an internal 
transmitter constantly sends out pulses of radio frequency energy into the ice. This radio energy 
pulse reflects from the bottom of the ice and is collected by a receiver inside the Noggin GPR. 
The ice thickness data is saved and displayed in real time as a cross-sectional image (see Figure 
1-3). 

 

 

Figure 1-1: An IceMap survey in operation. A toboggan containing a Noggin system is being towed behind a truck. Ice 
thickness data is sent to a computer in the cab of the tow vehicle to display and save. 
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Figure 1-2: A depiction of an IceMap survey. The vehicle tows the Noggin GPR system, which sends radio pulses into 
the ice to measure ice thickness. The data is saved and displayed on a computer, which is usually located in the cab of 

the truck. 

 

Figure 1-3: Typical IceMap data. The white-black-white bands are the reflection from the bottom of the ice. The bottom 
of ice should be picked at the top of the highest band; in this case the white band is indicated by the blue line. The ver- 

tical scale is about 200 centimeters and the horizontal scale is about 400 meters. The ice thickness in this area is 
about 100 to 120 centimeters thick. 
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2 IceMap SmartTow System Assembly 

The IceMap SmartTow system consists of a Computer, the Electronics Box, and a Sled as shown 
below, in Figure 2-1. 

The computer, usually kept in the cab of the tow vehicle, is connected wirelessly to the 
Electronics Box in the sled. 

Figure 2-1: IceMap SmartTow system parts. 
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2.1 Electronics Box 

The IceMap Electronic Box is a hinged, plastic case on wheels that houses the Noggin GPR 
sensor, NIC (Network Interface Controller), GPS, Wireless Access Point, and Power Distribution 
(Power over Ethernet [PoE]) box which are all powered by a 12 volt rechargeable Battery. 

All connections, except the power connection to the battery, are made at the factory. If any cables 
are disconnected, refer to Figure 2-2 below, and follow the instructions to reconnect them. 

 

 

Figure 2-2: IceMap SmartTow Electronics Box components. 

 

1) Connect the black Noggin-to-NIC cable’s 37-pin male D connector to the Noggin GPR 
Sensor (under the divider). Tighten the latch to secure this attachment. 

2) Feed the cable through the square hole in the divider and then attach the Noggin-to-NIC 
cable’s 37-socket female D-connector end to the 37-pin receptacle on the NIC. Tighten 
the latch to secure this attachment. 

3) Connect the Y-shaped GPS Serial Power Cable to the GPS receiver, the NIC, and the 
PoE box: 

a) Connect the square 12 pin female connector to the GPS receiver. 

b) Feed the 9-socket female serial cable through the narrow rectangular hole in the 
divider and then attach it to the 9-pin male serial connector on the NIC. Secure this 
connection with the thumbscrews. 
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c) Feed the round 4-pin cable through the slot in the divider and then attach it to the 12 
V-out connector on the PoE Box. 

 

4) Connect the NIC-to-PoE cable from the Ethernet port on the NIC to the Ethernet port 
labelled NIC on the PoE Box. Tighten the screw caps on both ends to secure this 
connection. 

Important: Ensure this connection is correct. Connecting the NIC to the Wi-Fi Ethernet 

port on the PoE Box will damage the system. 

 
5) Connect the Wireless Access Point cable to the Ethernet port labelled Wi-Fi on the PoE 

Box: 

a) Feed the cable through the small round hole in the divider and then attach the other 
end to the wireless access point Ethernet port (underneath the divider). 

b) Tighten the screw cap to secure the connection. 
 

6) Connect the yellow Power Cable from the 12V IN port on the PoE Box. Connect the 
other end of this cable to the 12 Volt battery. 

Note: Do not connect the battery until you are ready to power up the system and acquire 

IceMap data (to learn more, see Chapter 4, Powering the IceMap System). 

 

2.2 Noggin GPR Sensor 

The Noggin GPR sensor is stored under the Electronic Box divider and can be rotated 90 
degrees. To do this, lift the divider and then move the Noggin GPR Sensor to the new position; 
the foam cutout under the divider has two positions for the sensor. 

When using IceMap on Sea Ice (section 17.5, Appendix A Special Considerations for Sea Ice), 
you may need to turn the Noggin GPR Sensor 90 degrees (perpendicular) to see the bottom of 
the ice reflector. 
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Tie-Down Rings 

 

2.3 Positioning the Electronics Box in the IceMap Sled 

The IceMap Sled is composed of durable plastic with minimal metal so as to not interfere with the 
Noggin GPR sensor. 

The Tow Bar connection at the front of the sled is designed to attach to different types of 
vehicles. When the unit is shipped, the tow bar is separate from the sled and must be attached 
using the bolts provided. 

Four metal Tie-Down Rings are attached to the inside bottom of the sled. Connect the ratcheting 
straps to the tie-down rings to secure the electronics box to bottom of the sled. 

 

Figure 2-3: The IceMap SmartTow tie-down rings attached to the inside bottom of the sled to secure the ratcheting 
straps. 

 

1) Position the non-slip pad slightly toward the front of the sled (Figure 2-4). 

Figure 2-4: Place the non-slip mat in the bottom of the sled. 
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2) Place the electronics box in the bottom of the sled. 

This position ensures that the Noggin sensor is as close to the ice surface as possible so 

that maximum GPR signals penetrate into the ice. 

 
3) Position the Electronics Box so that the rolling wheels on the case face the back of the 

sled so that the wireless electronics will be close to the tow vehicle and computer. 

This position ensures that the Noggin GPR sensor is in optimal position to enable maxi- 
mum GPR signal penetration into the ice surface.Make sure that the ratchet straps are 

facing the back of the sled. 

 
4) Attach the strap to the front tie-down (facing the tow vehicle) ring (see Figure 2-3). 

a) Feed the strap through the back handle of the electronics box, around the side of the 
box, and then through the front handle. 

a) Attach the strap to the back tie-down (away from the tow vehicle) ring. (Figure 2-5). 

b) Use the ratchet to tighten the straps. 
 

Note: Avoid over-tightening the strap as it may warp the sled. 

 
5) Repeat step 5 to attach the second strap to the other side of the Electronics Box. 
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Ratcheting Straps 

Electronics Box wheels 
towards the back of the sled 

 

Strap placement secures the electronics box while allowing the lid to be opened easily. 
 

 

Figure 2-5: The Electronics Box position n the sled. The wheels facing the back to ensure the strongest wireless signal 
to the computer. The Electronics Box is secured to the bottom of the sled by hooking the straps to the metal rings and 

positioning the straps as shown. Ratchet the straps tight. 
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2.4 The Computer 

IceMap SmartTow data is displayed and stored on a ToughBook computer. The computer is 
usually kept inside the cab of the towing vehicle where operators can control data acquisition and 
monitor data as it is collected. 

 
 

Warning: It is very important that the ToughBook computer only be operated in temperatures 
higher than -25C (-13F) otherwise sensitive electronic components, including the LCD screen 
may freeze. Never start the computer immediately after it has been exposed to cold temperatures. 

 

 
If you must operate the computer in temperatures below -25C (-13F), store it in a wind-proof box 
that is insulated with styrofoam or textiles and heat the inside with hand-warmer packs. 

When possible, start the computer in a warm temperature before placing it in the box. If the 
protective box is properly insulated, the computer can usually generate enough heat to keep 
itself warm. 
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3 IceMap Base System Assembly 

3.1 IceMap Parts 

The IceMap Base system consists of the following parts (as shown in Figure 3-1): 

• Computer (see Section 2.4) 

• Network Interface Controller (NIC) 

• Computer-to-NIC Cable 

• Noggin-to-NIC Cable 

• Noggin GPR Sensor 

• Battery 

• Battery Charger 
 
 

Figure 3-1: IceMap system parts. 
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3.2 IceMap Base Cable Connections 

1) Connect the NIC to the Noggin GPR with the Noggin-to-NIC cable. 

The Noggin-to-NIC cable has a built-in power cable that connects to a battery to power 
the system. 

 
a) Connect the Noggin-to-NIC cable 37-pin male D connector end to the Noggin GPR 

Sensor. Tighten the latch to secure this attachment. 

b) Connect the Noggin-to-NIC cable 37-socket female D-connector end to the 37-pin 
receptacle on the NIC. Tighten the latch to secure this attachment. 

 

2) Connect the Computer-to-NIC Ethernet cable with the threaded cap from the Ethernet 
port on the NIC to the Ethernet port on the computer. Tighten the screw cap to secure the 
connection to the NIC. 

3) Connect the round 4 pin end of Battery Power Cable to the 12 Volt battery. 

Note: Leave the battery unconnected until you are ready to power up the system and 
acquire IceMap data (to learn more, see Chapter 4, Powering the IceMap System). 

 
 
 

 
Figure 3-2: IceMap system assembly. 
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3.3 Preparing the Sled 

When profiling ice, the IceMap Base system is usually towed behind a vehicle and is protected in 
a sled supplied by your company. 

The following should be taken into consideration when setting up the sled for IceMap use: 

• The sled should have a minimal amount of metal because metal can cause interference 
and excess noise in the data 

Important: Ensure that the bottom of the sled does not have metal runners. 

• Fasten the Noggin GPR Sensor to the bottom of the sled as close to the ground as pos- 
sible 

• Secure the cable to the sled so that the electrical connection is not stressed (Figure 3-3) 

Note: Protect the Noggin's electrical connection from excessive snow and water. It is a best 

practice that the sled have protective sides, otherwise place the Noggin in the bottom of a 

plastic container, a cooler for example (as shown in Figure 3-4). 

The following figures show different IceMap configurations: 
 

a) Place the computer, NIC, and battery together in the cab of the tow vehicle. Run a 
long Noggin cable from the cab to the Noggin GPR in the sled. 

b) Place the computer in the cab of the tow vehicle. Connect the Computer-to-NIC 
Ethernet cable to the NIC which, along with the Battery and Noggin GPR Sensor, are 
set up in the sled. 

 

c) For a hand-held system, keep all the components together and connected with short 

cables. 
 

When deploying configurations a and b, complete the following procedure to ensure maximum 
protection of the Noggin GPR Sensor: 

 

1) Place the sensor on the bottom of the sled in a plastic container surrounded by foam to 
prevent movement. 

2) Cut a hole in the side of the container so that the Noggin cable can fit through it. 

3) Add some strain relief to the cable so that the cable will not break if the system is pulled 
by the cable. In Figure 3-3, a rubber tube is tightened around the cable to provide strain 
relief. 
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Figure 3-3: To protect the Noggin GPR Sensor, place it at the bottom of the sled in a plastic container surrounded by 
foam to prevent movement. Cut a hole in the side of the container for the Noggin cable to fit through. Make sure to add 

some strain relief to the cable because the cable will break if the system is pulled by the cable. In the figure above 
right, a rubber tube is tightened around the cable to provide strain relief. 

 
 
 

Figure 3-4: The Noggin GPR Sensor sealed into the container is mounted into the sled for towing. Ensure that the 
cable has strain relief so it does not break if pulled. 
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3.4 The Computer 

IceMap SmartTow data is displayed and stored on a ToughBook computer. The computer is 
usually kept inside the cab of the towing vehicle where operators can control data acquisition and 
monitor data as it is collected. 

 
 

Warning: It is very important that the ToughBook computer only be operated in temperatures 
higher than -25C (-13F) otherwise sensitive electronic components, including the LCD screen 
may freeze. Never start the computer immediately after it has been exposed to cold temperatures. 

 

 
If you must operate the computer in temperatures below -25C (-13F), store it in a wind-proof box 
that is insulated with styrofoam or textiles and heat the inside with hand-warmer packs. 

When possible, start the computer in a warm temperature before placing it in the box. If the 
protective box is properly insulated, the computer can usually generate enough heat to keep 
itself warm. 
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3.5 GPS 

IceMap enables you to attach a GPS (Global Positioning) unit with a serial output cable directly to 
the 9-pin serial port on the front of the NIC using the thumbscrews (Figure 3-5). 

 

Figure 3-5: A GPS connected to the serial port on the NIC. 

If you are supplying your own GPS unit, and it is not powered by internal batteries, you will need 
to supply a separate battery to power the unit. 

GPS units supplied by Sensors & Software come with a battery splitter cable to allow the 12 Volt 
system battery to power both the IceMap system and the GPS (Figure 3-6). 
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Figure 3-6: A GPS connected to the serial port on the front of the NIC using a serial connection. 

If the GPS data is output to the NIC across the serial port, the IceMap computer’s data acquistion 
program can be configured to read the data and store it along with the IceMap data (to learn 
more, see Section 6.2.2.1 Configuring the GPS). 
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3.6 Optional Odometer 

An odometer is an optional accessory that uses the vehicle transmission or a rolling wheel to 
trigger data collection at equal intervals along the surface. An odometer ensures that the 
distance on the ground between data sample points, or Step Size (Section 6.1.4.2) does not 
depend on the speed of the vehicle. For example, data collection may vary as the vehicle speed 
changes, but the step size always remains constant. 

There are two types of odometers available for the IceMap system: 

• Vehicle Transmission Odometer 

• Wheel Odometer 
 
 

Figure 3-7: Optional odometers available with the IceMap system: vehicle transmission odometer (left) and wheel 
odometer (right). 

When data is collected without an odometer, the operator must drive at a constant speed to have 
a consistent step size. This type of data collection is referred to as a Free Run (Section 6.1.3.1) 
operation. 

Details for connecting the transmission odometer are described in the documentation that is 
included with the transmission odometer. 
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4 Powering the IceMap System 

To power-up the IceMap SmartTow system Electronics Box, connect the Power Cable to the 
battery (Figure 2-2). 

To power up the IceMap Base system, connect the power cable to the battery. 
 

 

 
Figure 4-1: Connecting the IceMap power cable to the battery in the Electronics Box. 

 

4.1 NIC LCD Status Messages 
 

 

Figure 4-2: The NIC LCD screen provides status information. 
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When the NIC is powered-up, it starts an initialization sequence and the NIC LCD panel displays 
the following status messages: 

 

1)  

 
2) 

 

3)     NIC MAC Address (may be different than shown). 

Note: the first digit of the address is truncated; it is always zero (0). 

 
 

4) NIC IP address (may be different than shown). 

5) GPR Type: Noggin or pE PRO. 

 

6)     IP address of the host computer that the NIC will attempt to 
establish a connection with (may be different than shown). 

 

7)      The NIC is ready. It can now be detected by the IceMap data 
acquisition software on the computer 

NIC initialization generally takes about 45 seconds. 

 
Once initialized, the LCD panel on the front of the NIC unit displays diagnostic information that 
includes network status: 

• The first line displays the NIC IP address 

• The letters LNK are displayed in the right side of the lower line to confirm that a physical 
network connection is present 

• The screen displays flashing ACT letters when there is network activity 
 

•   This screen image means there is a link and activity on the 
network connection 

• When the LCD displays the IP address and the link/activity indicators on the bottom 
line, the NIC is ready to accept connections from a computer 
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4.2 Wireless Access Point (IceMap SmartTow Only) 

The IceMap SmartTow system uses an access point (Figure 2-2) in the Electronics Box to 
wirelessly send IceMap data to the computer.  

 

4.3 IceMap SmartTow Sled Cover 

Once the Electronics Box has been powered-up, close the lid and then cover the sled with the 
fabric cover to prevent snow and debris from collecting in the sled. 

 

 

 
Figure 4-3: The Electronics Box in the sled with sled cover. The cover prevents material from collecting in the sled dur- 

ing data collection. 
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5 IceMap Data Acquisition Software 

 
 

1)   To open IceMap, double-click the desktop icon . 

Alternatively, click Start and then select All Programs > Sensors & Software GPR > 
IceMap. 

 
 
 

Figure 5-1: IceMap main screen. 

The IceMap main screen displays a cross-section image of the IceMap data with a horizontal 
position scale across the top and a vertical depth scale along the right side. These scales have 
position and depth units in meters (m) and centimeters (cm) if the units are Metric, and feet and 
inches if the Units (Section 6.1.2) are US Standard. 

The Depth Scale displays a blue bar at the current ice thickness, a red bar at the minimum ice 
thickness, and a green bar at the maximum ice thickness of the line. 

 

5.1 Threshold Line - Thin Ice Warning 

An orange horizontal threshold line is plotted on the IceMap data cross-section image. If the 
current ice thickness is less than the threshold, the Current Thickness value flashes red and an 
audible alarm sounds. 
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To change threshold value, use the up and down arrow keys on the Toughbook computer. 

Alternatively: 

 

 
1) Click . 

2) Click the View Settings dialog box View Settings tab. 

3) In the Threshold Level (Section 7.1.3) pane, change the threshold level number. 

 

5.2 IceMap Sidebar 

The Sidebar displays the following data: 

• System Status 

• GPS Status 

• Minimum Ice Thickness on the current line 

• Current Ice Thickness 

• Maximum Ice Thickness on the current line 

• Ice Cal Value 
 

5.2.1 GPS Status 

GPS position is displayed in Latitude/Longitude or UTM depending on the GPS Units setting (to 
learn more, see GPS Format Section 7.1.4). 

To view details about GPS, including signal strength, number of satellites, time, position, and 

elevation, click GPS Status . 

5.2.2 Min 

The Min field displays the Minimum ice thickness for the current line. 
 

5.2.3 Current 

The Current field displays the current ice thickness in the depth scale. 
 

5.2.4 Max 

The Max field displays the Maximum ice thickness for the current line. 
 

5.2.5 IceCal 

Ice Cal represents the speed of the GPR signal through the in millimeters per nanosecond. A 
typical value is 140 to 170, but can vary from site to site. 
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5.3 IceMap Toolbar 

The IceMap toolbar displays a number of buttons for data acquisition, changing the system 
settings and changing the view settings. 

Use the following table as a guide to working with the IceMap Toolbar: 
 

 

 

Open a previously collected line (to learn more see Chapter 10 Displaying a Previously 
Collected Line). 

 

 

Start a new line or turn off the system pause (to learn more see, Chapter 8 
Collecting IceMap Data). 

 

 

Pause data collection on the selected line (to learn more, see section 8.2.6 Pausing 
Data Collection). 

 

 

Stop data collection of the current line (to learn more see Chapter 9,Reviewing and Edit- 
ing Data). 

 

 

System Settings allows you to change Depth, Step Size, and Speed (to learn more, 
see Chapter 6 System Settings Menu). 

 

 

During data collection, click the Ice Calibration icon to enter a known ice thickness 
measured from a core (to learn more, see section 8.2.6.1 Ice Calibration). 

 

 

During data collection, click the Fiducial Marker icon to add a marker to the line at the 
current position (to learn more, see section 8.2.5 Fiducial Markers). 

 

 

Click the Increase Gain icon to increase the amplification of the signal (to learn more, 
see section 8.2.4 Gain). 

 

 

Click the View Settings icon to change your IceMap settings (to learn more, see Chap- 
ter 7,View Settings). 

 
 

 

Click the IcePicker icon to launch the IcePicker program (to learn more, see Chapter 13 
IcePicker Software). When IcePicker is launched, IceMap remains open. Any editing 
done in IcePicker / IceMap will not be reflected in the other program until the data is 
reloaded. 

 

 

Click the Launch Google Earth icon, if the application is installed on your computer (to 
learn more, see section 9.4 Google Earth Path). 

 

 

Click Help to open the IceMap User Guide (to learn more, see Chapter 11 Help). 
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27 

IceMap 6-System Settings Menu 
 

 

 

6 System Settings Menu 

The System Settings dialog enables you edit the system settings. 

 

 
To open the system settings dialog box, in the IceMap toolbar, click System Settings . 

 
 

 

 
6.1 General Tab 

Figure 6-1: System Setup Menu 

 

The System Settings General tab contains features that enable you to identify your project, 
define how your data will be measured. 

 

6.1.1 File Management 

Project Name is the name of the folder the IceMap data files are saved to. The default project 
name is “Project1.” 

To learn more, see Section 6.2.1 (the Data Folder section) for the path where the IceMap data 
files are saved. 

Line Prefix is the name that lines will start with before an incrementing number starting at 0000. 
For example, a Line Prefix of RedRiver will create files with names like RedRiver0017; the default 
line prefix is Line. 
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6.1.2 Units 

Select whether to measure data using Metric or US Standard units. 

Click Metric to display speed, position, and depth values in kilometers/hour, meters, or 
centimeters. 

Click US Standard to display speed, position, and depth values by miles per hour, feet, and 
inches. 

 

6.1.3 Triggering 

Set this parameter to define whether to gather IceMap data collection using Free Run or an 
Odometer. 

 

6.1.3.1 Free Run 

Click Free Run when you will not be using an odometer with the system. 

Selecting Free Run mode adjusts the current system settings to prompt IceMap to automatically 
collect the required data. The positional accuracy of GPR data collected in free run mode is 
controlled by the speed the system is traveling relative to the user defined speed setting (to learn 
more, see Speed and Maximum Speed Section 6.1.4.3). 

 

6.1.3.2 Odometer 

Click Odometer when an odometer is connected to the IceMap system (to learn more, see 
Optional Odometer, Section 3.6). 

Note: it is very important to accurately calibrate an odometer to ensure accurate positioning (to 
learn more, see Odometer Calibration Section 6.2.3). 

 

6.1.4 Collection 
 

6.1.4.1 Depth 

Click the Depth drop-down list to select the total depth for collecting GPR data: 

• If units are Metric, select a predefined value of 0.5, 1, 2, 3, 5 or 10 meters from the 
drop-down list. 

• If units are US Standard, select a predefined value of 2, 4, 6, 10, 20 or 30 feet from the 
drop-down list. 

Typical value is 1 to 2 meters or 2 to 6 feet. 
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6.1.4.2 Step Size 

The suggested value for step size is 0.5m for lake ice and 0.25m for river ice (due to more 
complex environment for ice formation and more variable thicknesses). 

 

Free Run Mode 

When you set Triggering (Section 6.1.3) to Free Run, the distance is estimated between data 
collection locations along the ice profile; this is referred to as Step Size. A typical Step Size value 
is 0.25 to 1.0 m or 1 to 3 feet. 

 

Figure 6-2: Step Size is the distance between data collection points. 

• If units are Metric, select a predefined value of 0.05, 0.1, 0.20, 0.25, 0.5 or 1.0 meters 
from the dropdown list. 

• If units are US Standard, select a predefined value of 0.1, 0.2, 0.5, 1.0, 1.5, 3 or 6 feet 
from the dropdown list. 

The accuracy of the estimated Step Size will vary depending on the speed the data was 
collected at relative to the speed you defined in Speed and Maximum Speed Section 6.1.4.3. 

If the data was collected at a faster speed than the one defined in the Speed setting, the data will 
have a larger step size than indicated by this setting. If the data was collected travelling at a 
slower speed, then the data will have a smaller step size than indicated by this setting. 

 

Odometer Mode 

When you set Triggering set to Odometer, the system collects data at the desired Step Size 
increment. The accuracy of the Step Size depends on the accuracy of the Odometer Calibration 
(Section 6.2.3) 

 

6.1.4.3 Speed and Maximum Speed 

From the Speed drop-down list, select average speed of the target tow vehicle speed for data 
collection. 

• If units are Metric, click a predefined value of 1, 2, 5, 10, 15, 20, 25, 30, 40, 50, 60, or 
80 km/hr 

• If units are US Standard, click a predefined value of 0.5, 1, 2, 5, 10, 15, 20, 25, 30, 35, 
40, or 45 mph. 
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The Maximum Speed for the current depth and step size is displayed. This value may be less 
than 80 km/hr or 50 m.p.h. if the depth setting is high and the step size setting low. 

 

6.2 Advanced Tab 

The System Settings Advanced tab enables you to define where the Data Folder (Section 
6.2.1) will be stored, the GPS Setup (Section 6.2.2) configuration, and Odometer Calibration 
(Section 6.2.3) 

 

 

 

6.2.1 Data Folder 

Figure 6-3: System Settings Advanced tab 

 

The Data Folder represents the path and folder name where the IceMap data files are saved on 
the computer. 

Click Browse to select a a drive letter and folder name. 
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6.2.2 GPS Setup 

The Global Positioning System (GPS) uses special satellites to determine the position of a GPS 
receiver located at any position on the surface of the Earth. 

Collecting IceMap data by GPS displays where data has been collected and enables you to 
extract the location of thin or problem ice areas from IceMap data. GPS also allows ice thickness 
data to be plotted on Google Earth using the IcePicker Software (Chapter 12) or as a map image 
using Troubleshooting.(Chapter 14). 

The IceMap SmartTow system has a GPS integrated into the Electronics Box (Section 2.1). 

The IceMap Base system allows a GPS (Section 3.5) receiver, either supplied by Sensors & 
Software or your company, to be connected to the 9-pin serial connection on the NIC. 

GPS information is automatically integrated with the IceMap data; It is also saved as a separate 

(.gps) file in the data folder. Once data acquisition is complete, you can open the data in 

IcePicker which will automatically integrate the GPS and IceMap data. 

When a GPS is detected during data collection, it is recommended that you set the position scale 
to GPS Cumulative to display the position axis along the top of the data collection screen (Figure 
8-3). 

 

6.2.2.1 Configuring the GPS 

 

GPS Supplied by Sensors & Software 

GPS systems supplied by Sensors & Software are configured in the factory to work with your 
IceMap system. To learn how to connect your GPS to the NIC and Battery, see Section 3.5. 

 
 

User-Supplied GPS 

If you have a GPS that you want to use with the IceMap Base system, you may need to change 
the System Settings on the GPS output menu to accept NMEA string data (for details, refer to 
your GPS User’s Guide from the GPS manufacturer). 

NMEA strings contain positional or other information in specific formats. Each type of string is 
specified by a 5-character prefix. There are numerous NMEA strings but to integrate the GPS 
data into the IceMap data, the GPS must be sending the GPGGA string. 

 

6.2.2.2 GPS Setup Menu 

To define your GPS settings: 

 

1) In IceMap, click System Settings . 
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2) In the System Settings Advanced tab, click GPS Setup. 

The GPS Settings dialog box enables you to change your GPS unit settings. 
 
 

Figure 6-4: GPS Settings dialog. 

 
 

Baud Rate 

Baud rate represents the speed that data is sent from the GPS receiver to the serial port of the 
NIC. 

3) From the Baud rate drop-down list, click 4800, 9600, 19200, 38400, 57600, or 115200. 
 

 

Figure 6-5: Changing the Baud rate for the GPS. 

 

To select the correct baud rate, refer to your GPS User’s Guide, or experiment with the 

settings to find the correct ones for that particular GPS select a setting (click Test. The 

correct baud rate will display readable characters in the Test screen). 

 
4) Once the baud rate is set correctly, click Test to have the GPS information written to the 

screen. 
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End String 

Before using the GPS with the IceMap system, the software needs to identify the prefix of the last 
NMEA string being sent in each group. In the following example, Figure 6-6, all the strings are 
the same (GPGGA) so it is the last string that needs to be defined. Depending on the GPS, more 
than one string can be output; if so, the last one being sent in each group needs to be specified 
as the End String. 

To find the End String for your GPS, click Test and then note the first five characters on the last 
line after each series of strings is written to the screen. These are the five characters that you 
need to enter into the End String text box. 

Refer to the GPS User’s Guide for details on how to set up the receiver to output specific NMEA 
strings or groups of NMEA strings. 

 

System Test 

After Baud Rate has been entered, test whether the system is receiving the GPS output: 
 

1) Click Test. 

2) In the GPS Status dialog box, click the Strings tab. 

The system displays the NMEA strings that are being read successfully. 
 

 
Figure 6-6: The System Test screen showing NMEA strings output by the GPS. 

The system displays the NMEA strings that are being read successfully. 

 
3) Record the prefix of the last NMEA string in the list and then enter it in the End String text 

box. 

If the NMEA strings do not appear, change the Baud Rate. If this doesn’t work, refer to the 

GPS User’s Guide to learn how to modify the GPS settings so they output NMEA strings 

across its serial port. 
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4) Click the Status tab to display details about the GPS including signal strength, number of 
satellites, time, position. and elevation. 

GPS position is displayed in latitude/longitude or Universal Transverse Mercator (UTM) 

depending on the GPS Units setting (to learn more, see Section 7.1.4 GPS Format). 
 
 
 

 
Figure 6-7: The System Test screen showing the GPS Status. 

 

6.2.3 Odometer Calibration 

If the Triggering option (Section 6.1.3) is set to Odometer, it is important to calibrate the odometer 
for accuracy. 

Note: calibrate on the longest line possible to ensure accuracy. Calibrating on a 10m long line is 
not as accurate as a 100m line, especially if you’re collecting long lines. 

 

1) Measure the exact distance. Do not use the vehicle odometer to measure calibration 
distance. 

 

2) In IceMap, click System Settings  . 

3) In the System Settings dialog box, click the Advanced tab. 



35 

IceMap 6-System Settings Menu 
 

 

 

4) In the Odometer pane, click Odometer Calibration (see Figure 6-3). This option is only 
available when the system is running. 

 

 

5) in the Calibration Line Length field, enter the distance measured in metric or US 
standard units. 

6) Align your vehicle at the start point (the zero measurement) and then click Start. 

7) Drive to the end of the measured distance and then click Stop. 

8) To save the new odometer calibration, click Accept. 

To use the old calibration, click Cancel. 

9) To confirm that the odometer calibration is accurate, collect IceMap data over the 
measured distance and then check that the odometer reading is correct. 
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6.3 Status Tab 

The System Settings > Status tab displays information about the performance of the system. 

The battery, temperature, and Wi-Fi levels are displayed as horizontal bars: 

• When these bars appear green in color, the system is operating correctly 

• When these bars appear red in color, the system is indicating a problem in the corre- 
sponding component 

 

 

 
Battery: When the Battery level turns red it is time to recharge or replace the battery. 

Temperature: If the Temperature level turns red, the system is overheating and should be shut 
down and cooled off before proceeding. 

Wi-Fi: If the Wi-Fi level is weak, the IceMap electronics may be having difficulty communicating 
with the computer. 

The lower part of the Status tab displays system details: 

• The IceMap software version and serial number 

• The Noggin GPR Sensor frequency and serial number 

• The NIC embedded software version number and serial number 

If the Sensors & Software Service Department requires details about your system, click Copy 
Info to copy the system information to the clipboard so it can be pasted into a document or e- 
mail. 
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7 View Settings 

The View Settings dialog enables you to edit the IceMap data display settings. 

To open in the IceMap IceMap Data Acquisition Software (see Chapter 5) toolbar, click View 

Settings . 

 
 

Figure 7-1: View Settings dialog 

 

7.1 The View Settings Tab 

7.1.1 Depth Scale 

7.1.1.1 Interval 

The depth scale interval represents the distance between axis ticks on the depth scale. For 
example, the Interval on the depth scale in Figure 5-1 is 50 cm. 

Interval is normally set to Auto which calculates an appropriate distance depending on the Max 
Scale. Otherwise you can enter a specific labelled tick interval. 
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7.1.1.2 Max Scale 

Max Scale is the maximum depth that you want displayed on the IceMap cross-section. 

Note: This is the depth value that you want to display, not the depth value for data acquisition (to 
learn more, see Section 6.1.4). 

Max Scale can be set to a different value than the depth collected. For example, if the depth 
collected was two meters, set Max Scale to one meter. 

 

7.1.1.3 Show Grid Lines 

Clicking the depth scale Show Grid Lines feature displays horizontal line corresponding to the 
depth scale labels to be plotted on the cross-sectional data image (see Figure 5-1). 

 

7.1.2 Position Scale 
 

7.1.2.1 Mode 

The distances displayed on the Position Scale are based on GPS (if detected) or Triggering 
mode (Section 6.1.3): Free Run or Odometer. 

• If a GPS is detected, in the Position Scale drop-down list click GPS Cumulative. 

GPS Cumulative uses the GPS to calculate the total distance along the line. Be aware 

that low quality, inaccurate GPS receivers may return an inaccurate position scale. 

• If a GPS is not available, in the Position scale drop-down list, click Free Run. 

Free Run mode calculates the distance based on the Step Size (Section 6.1.4.2) and 

towing Speed (Section 6.1.4.3). The accuracy of the Free Run distance measurement 

depends on how closely the operator moves the system to the tow speed setting. 

 
The odometer calculates the distance based on the total number of traces multiplied by 

step size. For example, if step size is 0.5m and 100 traces have been collected, the cur- 

rent position is (100-1) X 0.5 = 49.5m (remembering that the first trace is at position 

0.0m). The accuracy of this position depends on the accuracy of the Odometer Calibra- 

tion (Section 6.2.3) and odometer wheel slippage. 
 

7.1.2.2 Range 

Range represents the total distance of data that you want to display on one screen in the 
selected units. 

• If units are Metric, select a predefined value of 50, 100, 200, 250, 300, 400, 500, 600, 
1000 meters, or All. 

• If units are US Standard, select a predefined value of 150, 300, 600, 800, 900, 1200, 
1600, 2000, 3000 feet, or All. 

Selecting All displays all the data from the survey on the IceMap screen at one time; This makes 
finding the thinnest sections of the survey easier. 

Note: The “All” feature is only available during playback. To learn more, see Section 10.2. 
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Positions are always based on the set Speed (Section 6.1.4.3), not the actual towing speed, so if 
the towing speed is not the same as the indicated collection speed, there may be a small 
discrepancy in the total distance if Position Scale mode is set to GPS Cumulative (Section 
7.1.2.1). 

 

7.1.2.3 Show Grid Lines 

Click the position scale Show Grid Lines to display vertical lines corresponding to the position 
scale labels plotted on the cross-sectional data image (see Figure 5-1). 

 

7.1.3 Threshold 

The Threshold Level is represented in the IceMap main screen (Section 5) by an orange 
horizontal line that is plotted according to a user-defined ice thickness value. If, during data 
collection, the auto-picked ice thickness goes above the threshold, the IceMap Current Ice 
Thickness sidebar indicator flashes red and an audible warning alarm sounds. Example, if you 
set the threshold to 50 cm and the ice is picking at 65 cm, there will be no warning. But, if the ice 
gets as thin as 50cm then the system will beep and flash. 

To change the ice thickness threshold value, in IceMap Base system, in the Threshold Level 
drop-down list, select a new value. 

Alternatively, from the main screen, press the up and down arrows on the computer keyboard. 

When saving data and the collection of a line stops, or replaying a previously collected data line, 
the entire line is re-displayed on the screen. The Playback Bar is displayed along the bottom of 
the screen (see Figure 10-1). An orange outlined box indicates, along the entire data line, where 
ice is thinner than the current threshold value. If the threshold value changes, this box 
automatically updates to display the thin areas based on the new threshold value. 

 

7.1.4 GPS Format 

GPS Format enables you to select a format for displaying GPS information (Latitude/Longitude 
or UTM). 

To display GPS position, click the GPS Status box (Section 5.2.1). 

Alternatively, in the same GPS Status dialog, click System Settings > Advanced tab > GPS 
Setup > Test > Status tab (see GPS Setup Menu Section 6.2.2.2). 

 

7.2 Ice Cals Tab 

The Ice Cal value ranges from 100 to 250 and represents the speed of the GPR signal through 
the ice. The Ice Cal number represents the ice velocity value in millimeters per nanosecond. A 
typical value is 140 to 170 but it will vary from site to site depending on several factors, such as 
the amount of air and liquid water in the ice. 

Accurate IceCals values result in accurate ice thickness data. 

Ice Cal values are calculated by completing an Ice Calibration (Section 8.2.7.1) after pausing 
during data collection. 
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1) To view the Ice Cal values collected on the current line, in the IceMap IceMap Data 

Acquisition Software toolbar (Section 5), click View Settings  . 

2) Click the Ice Cals tab: 
 

 

3) In the Base Ice Cal on section, select the Ice Cal value based on the Latest value, the 
Average value of all ice cals, or enter a value Manually. 

 

7.2.1 How Ice Thickness is Determined 

The Depth setting represents how deep the GPR signal attempts to penetrate to the subsurface 
(to learn more, see Section 6.1.4). 

Note: Depth setting is an estimated value that is dependent on the Ice Cal value of the ice. 

Ground penetrating radar systems record the time it takes a radio wave to travel to a target and 
back; they do not measure the depth to that target directly. The depth to a target is calculated 
based on the velocity (Ice Cal) at which the wave travels to the target and back. 

The calculation is as follows: 

D = V x T/2 

Where D is Depth (m) 
V is Velocity (m/ns) 

T is Two-way travel time (ns) 
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8 Collecting IceMap Data 

1) When you first run IceMap software, the System Status box displays the word Searching. 
 

2) Once the system is detected, the word Found appears and a progress bar is displayed 
as the system initializes. 

3) When initialization is complete and the system is ready to collect data, the message 
changes to Ready, and the green Start button is enabled for data collection. 

 

4) To start data collection, on the IceMap toolbar (Section 5.3) click Start . 

8.1 Select a Line Name 

After you click Start, the system prompts you for a Line Name (see image below). A default name 
populates the text box; the default name is based on the Line Name (see File Management 
Section 6.1.1). 

The incrementing number is listed, but you can also generate a new default name by clicking 
Default Name in the New Line dialog box; the default line name can be edited or overwritten. 

The system enables you to save data to the file name or run without saving data. If data is not 
saved to a file, the data is lost once it scrolls off the edge of the screen. 

 
 

Figure 8-1: The New Line dialog allows users to accept a default name or type a line name or collect data without sav- 
ing it. 

 

8.2 Starting Data Collection 

The system displays a summary of the Project Name, Line Name, Battery Level, and Towing 
Speed. 
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Click anywhere on the screen to start collecting data. 
 

 

 
Figure 8-2: Check that the information is correct and click anywhere on the screen to start collecting data. 
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8.2.1 The Data Collection Screen 

Data traces scroll onto the screen from right to left; the current data trace is on the right edge of 
the screen. 

 

 

 
Figure 8-3: Data collection screen. 

 

8.2.2 Ice Thickness Values 

The left side of the screen displays the Minimum (Min), Current, and Maximum (Max) ice 
thickness for the current line. 

To reset Min and/or Max values, click the number and then select Reset Ice Thickness. This 
feature is useful when the Min ice thickness value is not accurate because the survey line started 
on shore or passed over grounded ice. 

 

8.2.3 Position Scale 

If Triggering is set to Free Run Mode (Section 6.1.3.1) drive at the specified Speed (Section 
6.1.4.3). If a GPS is attached and the system is moving faster than the speed setting, a message 
is displayed on the screen prompting you to slow down. 



44 

8-Collecting IceMap Data IceMap 
 

 

 

If Triggering is set to Odometer Mode (Section 6.1.3.2) drive at any speed below the Maximum 
Speed. Maximum Speed is also displayed on the start screen. 

Free Run or Odometer with GPS 

If a GPS is detected and collecting data in Free run or Odometer mode with the Position Scale 

set to GPS Cumulative, the Position Scale Section 7.1.2 (across the top of the screen is based 

on the cumulative GPS distance). The cumulative GPS position is the sum of the distances 

between all the traces collected. 

Note: It is important to understand that the cumulative GPS distance will vary depending on the 

accuracy of the GPS used. 

Free Run with No GPS 

If you have set the Position Scale to, and are collecting data in Free Run Mode, the position scale 

results are based on the total number of traces multiplied by the Step Size (6.1.4.2). 

For example, if Step Size is 0.5m and 100 traces have been collected, the current position is 

(100-1) X 0.5 = 49.5m (remember that the first trace is at position 0.0m). The accuracy of this 

position depends on how closely the operator tows the system at the towing Speed. 

Odometer with No GPS 

If you have set the Position Scale to, and are collecting data in Odometer Mode, the position 

scale results are based on the odometer. The accuracy of this position depends on the odometer 

accuracy including odometer calibration and wheel slippage. 

 

8.2.4 File Size 

IceMap data files can have any number of traces (up to hundreds of thousands) but it is a good 
idea to limit file sizes because, if the power is interrupted to the IceMap system during data 
collection, the current file will not be saved. Only collect a data line length that you are willing to 
re-collect if there is a problem with the system. 

 

8.2.5 Gain 

If, during data collection, the bottom of ice reflector appears weak, the operator can increase the 

gain or amplification of the signal by clicking Gain   on the IceMap Toolbar. 

The current Gain value is displayed in the bottom right corner of the button. In Figure 8-3 the gain 
number is 1. Gain represents a value from 1 to 5, low gain to high gain. It is typically set to 1 and 
only increased when necessary. 

Clicking the Gain button with the Gain set at 5 resets to the Gain back to 1. 
 

8.2.6 Fiducial Markers 
 

To  enter fiducial markers into the survey data, click  Fiducial on the IceMap Toolbar during 
data collection. 
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This displays a red triangle on the bottom edge of the data image with in incrementing number, 
i.e. F1, F2, F3, etc. (to learn more, see Figure 5-1). 

To add a fiducial marker after the system has passed a point of interest (the point must still be 
displayed on the screen): 

 

1) Pause data collection (Figure 8.2.7). 

2) Click the point of interest. 

3) Click the Fiducial button. 

Fiducial markers typically mark significant points in the data such as, mile markers, landmarks, 
snowbanks, snow-covered areas, bumpy ice sections, flooded areas, surface water, surface 
slush, core locations, and so on. 

It is a best practice to take notes regarding the fiducial number and what it corresponds to. This 
can be very helpful when analyzing the IceMap data later. 

 

8.2.7 Pausing Data Collection 

When the system is paused, the operator can obtain information about any data position on the 
data image, continue to collect data, complete an ice calibration, or stop and exit from the line. 

 

To pause data collection, on the IceMap Toolbar, click Pause . 

While data collection is paused, clicking anywhere on the data cross-section displays the line 
position, cursor depth, ice thickness and Latitude/Longitude: 

 

Figure 8-4: While data collection is paused, click anywhere on the image to display information about the ice thickness 
at the selected point. 
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To continue collecting data on the same line, on the IceMap Toolbar, click Start 
 

8.2.7.1 Ice Calibration 

Every survey line should include at least one ice calibration to ensure ice thickness accuracy. To 
complete an ice calibration: 

 

1) Stop the vehicle but continue to collect data for another three seconds to create a flat ice 

bottom reflector on the right side of the data collection screen. 

2) Click Pause. 

 

3) Click Ice Cal . 

4) Using the mouse cursor, click the position on the line where the ice cal will be performed: 
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5) Drill a hole at the same position as the Noggin GPR Sensor (you may need to move the 
toboggan out of the way) measure the thickness of the ice. 

 
 

 
Figure 8-5: At a location where IceMap data have been collected, drill a hole through the ice and measure the ice 

thickness. 

 

6) Click the Ice Cal button  again. 
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Figure 8-6: Press the 1-4 buttons to input the ice thickness value. 

The Ice Cal dialog box allows you to move the data image up or down so the red calibra- 

tion line corresponds exactly with the top of the white band representing the bottom of ice 

reflection. Alternatively, click Snap to Auto Pick to align the red calibration line to the 

blue pick line. 

 
7) Enter the ice thickness value obtained from the core measurement. 

8) Make a note of the Ice Cal value. 

9) If the Ice Cal value is acceptable, click Accept. 

If the Ice Cal not value is not acceptable, click Cancel. 

 
10) Record the Ice Cal value in a notebook for future reference. 

When the Ice Cal value is changed, the depth scale of the IceMap data image is automat- 

ically updated, depending on how the Ice Cal value is calculated (to learn more, see sec- 

tion 7.2 Ice Cals Tab). 
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8.3 Google Earth Path 

Note: This feature requires a GPS and is only available during data collection. To learn more, see 
Section 3.5 GPS. 

To display the Google Earth path for the line survey, in the IceMap toolbar, click the Google Earth 

button . 

If you have Google Earth installed, the application opens and plots the path, fiducials, and Ice 
Cals for the selected IceMap data line. 

 

Figure 8-7: IceMap SmartTow path displayed on Google Earth during data collection. 

Displaying both IceMap and Google Earth windows, enables you to monitor ice thickness using 
IceMap and the survey line position with Google Earth. 

If the IceMap data collection computer does not have internet access out in the field, before 
going out to the field to collect IceMap data, use Google Earth’s caching feature to save detailed 
Google Earth images of the survey area. To learn more, see Appendix F, Caching Google Earth 
Information. 
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9 IceMap Data Collection Tips 

9.1 Ice Calibrations 

Every IceMap survey line should have at least one Ice Calibration to ensure the accuracy of ice 
thickness measurements. It may be necessary to collect more than one ice calibration on a 
survey line if conditions change during the survey. Factors that influence collecting additional ice 
calibrations are: 

• Construction vs. Maintenance - More ice cores are required during ice road construc- 
tion than maintenance. 

• Proximity to Shore - more cores when close to shore 

• Water Depth - more cores in shallower water 

• Lake vs. River - more cores on rivers due to stronger currents 

• Currents - more cores on sections of lakes where there are known currents 

• Streams - more cores near stream inlets into lakes 

• Highly Variable Thickness - if the GPR thickness measurements are highly variable, 
more cores are recommended 

 

9.2 Collecting IceMap Data on Snow-covered Ice 

It is recommended that IceMap data be collected on ice with little or no snow; this provides the 
most accurate ice thickness measurements. When this is not possible, here are a few tips to 
follow when collecting with snow on the ice: 

Always perform your ice calibrations on the areas of thinnest ice. This will ensure that the ice 
calibration is lower than actual and consequently, as the ice gets thicker, IceMap will report that 
the ice is thinner than it actually is; erring on the side of caution for safety. This tip is also 
recommended even when there is no snow. 

Do not take the snow depth into account during ice calibrations. For instance, if the core has 16 
inches of ice and 4 inches of snow then calibrate with a measurement of 16 inches. This will 
decrease your ice calibration value but the thickness measurements will be most accurate in the 
thinnest sections of ice, where it is most important for safety. IceMap will tend to report the ice 
thickness is thinner than it actually is in the thicker areas but that is not as much of a safety issue. 

Try to perform your ice calibrations where the snow thickness is typical of the area being 
scanned. 

When weight bearing capacity is an issue, try to avoid scanning over snow drifts as they add to 
the variability in ice calibrations. Due to the insulating properties of snow, the thinnest ice is 
typically below large snow drifts. 

If it is not possible to avoid areas of thicker snow or where the snow thickness is varying then it is 
recommended to increase the number of ice calibrations performed to ensure safety. 
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9.3 Toboggan 

It is important that toboggan carrying the IceMap electronics box not bounce around too much 
during data collection; the less bouncing, the better the data quality. If necessary add a few 
sandbags to weigh down the togoggan to reduce bouncing, compress any snow to get the GPR 
sensor closer to the ice surface and track better. 
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10 Reviewing and Editing Data 

After exiting a line when data is being saved (Section 8.1) the data is re-displayed on the screen 
from the beginning of the survey. The Minimum, Current, and Maximum Ice Thickness values 
displayed in the sidebar are updated to the Minimum, Average and Maximum ice thicknesses 
values for the entire line. 

 

To stop and exit the line, on the IceMap Toolbar, click Stop  . 
 

 

 

 
10.1 Reviewing Data 

Figure 10-1: The Playback Bar 

 

When data is reviewed, IceMap displays the Playback Bar along the bottom of the screen. The 
Playback Bar highlights areas of ice that are thinner than the threshold value by a series of 
vertical orang lines. If the operator changes the threshold value, the Playback Bar is 
automatically updated to display the thinner areas based on the new threshold value making it 
easy to find all the positions of ice thinner than a specific threshold. 
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The Playback bar also displays the location of every Fiducial marker (red triangle) and Ice Cal 
(red squares). Click any position within the box to display that portion of the line. 

Playback Mode contains most of the features available in Chapter 5 IceMap Data Acquisition 
Software, except for Ice Cal, Fiducial Marker, and Google Earth. 

The Info button in the bottom left corner of the IceMap image can be clicked to toggle the display 
of the Line Name and Date. 

 

 

 
Note: The View Settings options enable you to alter images. For example, the Depth Scale Max 
value can be changed to display a greater or lesser depth of data, or the Position Scale Range 
can be changed to display more or less data on one screen, similar to a horizontal zoom. 

 

10.2 Editing Data 

If the IceMap survey line started and/or ended on land, or crossed an area of grounded ice, the 
picks in those areas are from the bottom of ice frozen to the ground surface. As a result, the auto 
picker might have a hard time picking the bottom of the ice (due to low amplitude pick) and the 
summary statistics will be inaccurate because of shallow grounded ice picks. 

These picks affect the ice thickness statistics, such as the minimum ice thickness value and, 
when in Review mode, result in more orange highlighted areas displayed below the threshold 
value; it is a best practice to remove these picks from the line. IceMap's Edit mode enables you 
to change these portions of a picked survey to create a cleaner, easier to read survey. 
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Figure 10-2: IceMap Editing Mode 

The blue bar, displayed at the bottom of the screen in the playback bar, defines area of the 
survey that have been picked. 

 

10.3 IceMap Editing Toolbar 

When IceMap is in Playback mode, the Ice Calibration, Fiducial Marker, and Google Earth icons 
are replaced by the following icons: 

 
 

• Click the Edit icon to start and end the editing process 

 

• Click the Add icon to repick data in the selected area of the survey 

 

•  Click the Remove icon to delete the ice thickness information from the selected 
area of the survey 

 

• Click the Generate Report icon to produce a summary report 
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10.3.1 Edit a Survey 

 
 

1) To edit an IceMap survey, in the IceMap Editing toolbar, click Edit . 

While you are in Edit Mode, the screen is frozen. You cannot scroll beyond what is dis- 
played on the screen. 

 
2) In the ToughBook touch screen, to select the area of the survey that you want to edit, click 

and drag the arrows on each side of the green selector box to define the position range 
you want to edit. Then click and drag the arrows on the top and bottom of the green 
selector box to define the depth range you want to edit (see Figure 10-2). 

 
 

• Click Remove to delete the ice thickness information from the selected area of the 
survey 

 

• Click Add to insert pick data into the selected survey area. 

• If the automatic picker selects the wrong event (layer of snow, noise signal, etc.), rather 
than the bottom of ice, press Remove to delete the current picks and use the depth 
range arrows on the top and bottom of the selector box to narrow the depth range so 
these other events are not inside the box. Then, click the Add button again. 

3) Click the Edit button again to save the pick edits and navigate to another section of the 
survey line. 

 

10.3.2 Generate a Summary Report 

The IceMap Report feature allows you to distill long IceMap surveys into a summary report. 

 

 
To Generate an IceMap Report, in the Editing toolbar, click Generate Report . 

The IceMap Report Viewer opens to allow you to preview the report before you save it. 

To complete and save the IceMap Data Summary Report: 
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Figure 10-3: IceMap Data Summary Report 

 

1) In the Survey Name text box, accept the default line name, or enter a name that may be 
more descriptive of the work you are doing. 

2) In the Survey Start text box, enter a description of where the survey started. 

3) In the Survey End text box, enter a description of where the survey was completed. 

4) In the Additional Information text box, enter any other information that will help the 
analysts better understand the data they are reviewing. 

For example, you could enter the weather information during the survey, the conditions of 

the ice at the beginning and end of the survey, or any other observations that may pertain 

to the survey. 

 
5) The Survey Name, Survey Start, Survey End and Additional Information fields are 

remembered and automatically filled in with the text from the last report. The text 
backgrounds are colored orange to indicate that the information may be no longer 
relevant and should be edited if necessary. 
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6) Click the Edit Exception Comments button to access a table where you can enter 
comments about why specific sections of Ice thickness data were excluded from the 
Summary Report. Typical reasons for excluding data include grounded ice, surface 
water, thick snow, stationary data and poor quality picks. 

 

 

Figure 10-4: Exception comments editor dialog. 

7) To refresh the report image after editing, click Refresh Preview. 

8) To open the report as a PDF after you have saved it, make sure the Launch PDF After 
Export button is enabled. 

9) To save the report, click Export to PDF. 
 

a) In the Save As dialog box, navigate to the folder on your computer where you want to 
save this report. 

b) In the File Name text box, type a name for the report. 

The Save as type drop-down list, defaults to PDF. 

c) Click Save. 
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Figure 10-5: Sample of an IceMap Summary Report. 
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10.3.2.1 Survey Summary 

• Survey: The name of the survey (the default line name, or a descriptive user-defined 
name for the survey data) 

• Survey File Name: The file name for the data file 

• Survey Start and End Positions: Descriptive and/or physical position where the sur- 
vey started and ended 

• Survey Date: The date the survey was done, not the date the report was created 

• Survey Length: The length of the survey (m/ft) 

• Measurement Interval: The survey step size 
 

10.3.2.2 Calibration Summary 

• Ice Calibration #: The order position of the Ice Cal (1,2,3...) 

• Ice Calibration Position: The position of the Ice Cal in the survey (m/ft) 

• GPS information for start and end positions and Ice Cal positions 

• Ice Cal Value: The Ice Cal value at the selected position in the survey 

• Measured Core Thickness: Ice thickness measured from the core 
 

10.3.2.3 Ice Thickness Summary 

• Ice Thickness Range (cm/in): A data summary of the 10 thinnest ice thicknesses 

• Total Length of All Sections: A list of the 10 thinnest ice thickness ranges, from the 
minimum thickness to 10 cm thicker in 1 cm increments. If units are feet, a list of the 10 
thinnest ice thickness ranges, from the minimum thickness to 5 inches in 0.5 inch incre- 
ments. 

• Longest Continuous Section Length 

Displays the total distance (m/ft): 

 
• Length: The length of the longest continuous section (m/ft) of ice that falls within 

the selected range. 

• Occurs At: The line position (m/ft) where the longest continuous section occurs. 

•GPS coordinates for the middle of the longest continuous section. 
 

10.3.2.4 Additional Information 

Enter any information the you want to pass on describing the conditions of the survey site; 
weather, ground conditions, and so on. 

 

10.3.2.5 Exceptions 

The Exceptions section shows areas that were manually removed during editing, such as off-ice 
zones, zones of grounded ice and areas of highly irregular ice formation that would not be 
accurately picked with the automatic ice thickness analysis. 
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10.3.2.6 GPS Plot 

The GPS Plot section shows a plan map of the survey path with the GPS path shown as a thin 
grey line. The locations with ice thickness information are indicated by a blue line plotted over 
the survey path. IceCal positions are plotted as red squares. Fiducial Markers are plotted as red 
triangles. Black X's delineate the start/end of each Ice thickness section profile shown at the end 
of the IceMap Summary report. 

 

10.3.2.7 Ice Thickness Profile 

The Ice Thickness Profile shows a cross-sectional plot of ice thickness values for the entire 
survey line. IceCal positions are plotted as red squares and Fiducial Markers are plotted as red 
triangles. 

For long profile lines, not all the ice thickness values can be plotted. For these lines, a number of 
ice thickness values from a small area are combined and the minimum value plotted. 

 

10.3.2.8 Ice Thickness Section Profiles 

The Ice Thickness Profile shows cross-sectional plots of ice thickness values for a series of sub- 
sections of the survey line. Each section is the same length with the length automatically 
determined based on the overall length of the survey line. 

IceCal positions are plotted as red squares and fiducial markers are plotted as red triangles. 

For long survey lines, not all the ice thickness values can be plotted. In these cases, a number of 
ice thickness values from a small area are combined and the minimum value plotted. 
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10.4 Displaying a Previously Collected Line 

 
1) To display a previously collected line, in the IceMap toolbar, click Open . 

2) In the Open dialog box, navigate to where your data is saved 

3) Select a DT1 file. 

4) Click Open. 

To learn more, see Chapter 9 Reviewing and Editing Data for more details on reviewing data. 

 

10.5 IceMap Data Processing 

After acquiring data, the IceMap data files can be viewed and processed using IcePicker 
Software (Chapter 13). IcePicker exports ice thickness data in CSV and Google Earth KMZ files. 
CSV files can be read by many programs including Excel. 

Use the optional Troubleshooting (Chapter 14) to plot map images of the IceMap data and then 
export them to Google Earth. 
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11 Help 

11.1 Help 

The Help > Help button opens a PDF version of this user’s manual. 

 

11.2 Reset to Defaults 

The Help > Reset to Defaults resets all the settings in the program back to default values. This 
can be useful to troubleshoot the program if you are having problems or unexpected behaviors. 

 

11.3 About 

The Help > About option displays details of the IceMap software including a description, Version 
and Release numbers and the copyright. 
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12 IcePicker Software 

The Sensors & Software’s IcePicker program provides estimates of ice thickness from IceMap 
data files. The software automatically locates and picks the arrival time of the transmitted pulse 
that has been reflected from the bottom of the ice. 

The GPR cross-section and picked arrival times are displayed on the screen as a grayscale 
image (with optional wiggle trace format). Incorrectly picked arrival times can be edited manually. 
The final picks can be saved to, or reloaded from, a pick file. 

Ice thickness estimates can be viewed or exported to spreadsheets and other applications for 
plotting. The location of each ice thickness measurement is obtained either from odometer or 
GPS positioning information stored in the GPR data files. 

 

12.1 Running IcePicker 

 
In the Ice Map SmartTow system toolbar, click the IcePicker icon . 

When IcePicker is launched, IceMap remains open. Any editing done in IcePicker (or IceMap) 
will not be reflected in the other program until the data is reloaded. 

Note: If IcePicker doesn’t launch, press Shift and click the IcePicker icon at the same time to 
prompt the open dialog box to open enabling you to access the IcePicker installation file. 

Navigate and select the IcePicker executable file. This only needs to be done once; the program 
will remember the location of the IcePicker program. 

 

12.2 Opening an IceMap File 

1) To open an IceMap file, in the IcePicker toolbar, click File > Open GPR (.dt1) File. 

2) In the Load GPR dialog box, select the file you to open. 

3) Click Open. 

The file opens in the Ice Picker Data Display. 

 

12.3 IcePicker Data Display 

The data file defaults to the grey-scale display shown in the Figure 12-1. 

To scroll through the data, in the GPR Plot pane toolbar, press the left and right arrow buttons 

below GPR Plot.  

The GPR Plot > Options menu allows you to display the Position Axis based on Traces, 
Cumulative GPS distance, or Odometer distance. The total range for the data file is shown and 
the range of data displayed on the screen at one time can be changed. 
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Move the mouse cursor on the data image to display information such as current GPS position 
and depth above the image. 

 
 
 

 
Figure 12-1: IcePicker display with traces plotted in grey-scale. 

If GPS data is integrated with IceMap data, the trace information line above the image will display 
a cumulative distance value of the mouse cursor position. This value is based on the difference 
between adjacent GPS points and usually provides the most accurate positioning information if 
the data was collected in Free Run (section 6.1.3.1) mode. 

Fiducial Markers added during data collection are indicated along the bottom of the IcePicker 
image and are labelled F1, F2, etc. 

The positions of Ice Calibrations are indicated by text that is displayed along the bottom of the 
IcePicker data image with the ice thickness and Ice Cal value, for example Core: 47cm. 

To display the Ice Cal information on the bottom left corner of the screen, move the mouse cursor 
to the Ice Cal position (Figure 12-1). 

When a fiducial marker and Ice Calibration are close together, there may not be enough room for 
the Ice Cal text; in this case the position of the Ice Cal is indicated by a small x. Moving the 
mouse cursor to that location will display the Ice Cal information on the bottom left corner of the 
screen. 
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To simultaneously display all Fiducial markers and Ice Cal values for the data line, in the 
IcePicker tool bar, click the View > GPR File Info. 

Figure 12-2 displays survey information from the.HD file. The Fiducial marker and Ice Cal 
information, including trace number, measured ice thickness, and Ice Cal value are displayed on 
the bottom of this screen. 

 
 

Figure 12-2: The HD file lists all the survey parameters including information on all the Ice Calibrations performed dur- 
ing the collection of the line. 
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12.4 Preferences 

The IcePicker Preference feature enables you to change IcePicker data display settings. 
 

1) To open the Preferences dialog box, in the IcePicker toolbar, click File > Preferences. 
 

. 

Figure 12-3: Preferences dialog. 

2) Use the following table as a guide to working in the Preferences dialog box: 

 

Field Description 

XYZ Position 
Information 

Select one of the following options to display your survey X, Y, Z position using 
UTM GPS, Latitude/Longitude GPS, or your Odometer. 

 

 
Export Ice Thickness 
Options 

• Select one of the following options to export and display your survey ice 

thickness data to Quick Map, CSV, or Text. 

• To display your survey data in Google Earth, click the Create Google 

Earth KMZ option. 

• Select the Launch Google Earth on Export option to automatically open 

Google Earth once you export KMZ files. 

Units Select the units to display and export the survey data. 

3) Click OK. 

Units can be set in the Preferences dialog at any time, independent of the units used during data 
collection. As a result, data collected in meters, can still be displayed in feet (US Standard). 
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12.4.1 Ice Calibrations 

The IcePicker Ice Calibration Analysis feature is used to set the ice velocity used to determine 
the ice thicknesses for the entire survey. It can be set using some or all the Ice Cals performed 
during the survey or by entering a value manually. 

 

1) To open the Ice Cal Analysis dialog box, in the IcePicker toolbar, click View > Ice Cal 

Setting. 

 

12.4.2 Ice Cal Analysis 
 

 

Figure 12-4: Ice Cal dialog to determine the ice velocity used for ice thickness calculations. 

2) Use the following table as a guide to working in the Ice Cal Analysis dialog box. 

The Ice Cal Analysis dialog lists details of all the Ice Cals collected on the data line. 

3) Use the following table as a guide to working in the Ice Cal Analysis Dialog box: 

 

Field Description 

Average Select this option to display the average Ice Cal data. 

User 
Select this option to use the average Ice Cal figure. The Calculator is enabled 
when you choose this option. 

 
Ice Cal (mm/ns) 

If you selected the User option, enter the Ice Cal amount in this text box. 
If you selected the Average option, the average IceCal is displayed in this text 
box. 

 
Calculator 

The Calculate button is enabled when you select the User option above. 
To prompt the system to assist you to calculate an appropriate value (to learn 
more, see section 11.4.3 Calculating Ice Cal). 

Pos Lists the positions (m/ft.) of the Ice Cals along the survey line 

Core T Lists the ice thicknesses measured from the cores 

Pick T Lists pick thicknesses from the IceMap data 
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Field Description 

Ice Cal Lists the calculated ice calibration value in mm/ns. 

 
Include 

If an Average value is selected and you don’t want a specific Ice Cal included 
in the calculation, in the Include column, double-click next to the selected Ice- 
Cal to change the display word to No. 

 

4) To view the data image at a specific Ice Cal, double-click the row data that you want to 
display. Arrows highlight the point to the data line. 

 

12.4.3 Calculating Ice Cal 

If the User option was selected in the Ice Cal Analysis dialog (Section 12.4.2), click Calculate 
prompts the Calculate Ice Cal dialog box to open. 

 

 

Figure 12-5: Ice Cal calculator. 

Use the Calculate IceCal dialog box to calculate an appropriate value based an Ice Thickness 
and Travel Time. 

 

1) In the Thickness text box, enter an amount in centimeters (cm). 

2) In the Travel Time text box, enter an amount in nanoseconds (ns). 

3) In the Ice Cal text box, enter an amount in millimeters per nanosecond (mm/ns). 

If you do not have an Ice Cal figure, enter the theoretical value of 160. 
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12.5 Picking the Bottom of Ice 

To automatically pick the bottom of ice that is reflected, in the IcePicker toolbar Automatic Pick 
pane, click the Pick button:. 

Note: Before pressing the Pick button, refer to the following procedure to ensure the Automatic 
Pick Options are suitable. 

 

12.5.1 Automatic Pick Options 
 

1) To open the Automatic Pick Options dialog box, in the IcePicker toolbar Automatic Pick 

pane, click Opt. 
 

 

 
Figure 12-6: The Automatic Pick Options dialog box. 

2) Enter the Data Range: 

Depending on GPR Plot Options for the Position Axis, the Range displays Traces, Odom- 

eter Distance, or GPS Distance. 

 
a) Enter the desired data range for the data line. Exclude traces at the Start and/or the 

End of the line that may have been collected over the ground. 

3) Enter the Pick Time: 

The Start Time should default to a time value just after the direct wave (the 3 or 4 strong 

bands at the top of the data image). If not, click the Default button or edit the Start Time 

with this value. For IceMap, the direct wave is usually over by 4 or 5 nanoseconds. The 

End Time can usually be left as the default value, which is the maximum time value for 

the line. 
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4) Select the Ice Mode option. 

5) Set the Reference Pulse to Synthetic+. 

6) Click OK. 
 

12.5.2 Picking Traces 

To pick the bottom of the ice reflection, in the Automatic Pick pane, click Pick. 
 
 

 
Figure 12-7: The blue line indicates the pick for the bottom of the ice. 

Review all picks by scrolling through the data. If the bottom of ice reflection has been picked 
properly (Figure 12-7) for all the data, skip down to Ice Thickness Data (Section 12.6). If there are 
problems with the picks, refer to the following sections for Re-Picking Traces (Section 12.5.3), 
Editing Picks (Section 12.5.4), and Deleting Picks (Section 12.5.5) 
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12.5.3 Re-Picking Traces 

If you encounter a number of errors in the picked data, try re-picking the data with different pick 
options. 

For example, the software may pick a shallow reflector rather than the ice bottom reflection 
(Figure 12-8). 

 

 
Figure 12-8: Poor picks can be improved by increasing the Start Time so the pick window does not include the strong 

signals at the surface. 

To improve the percentage of successful picks: 

• In the Automatic Pick Options dialog (section 13.6.1), increase the Time Window Start 
Time to a value after the strong surface signals. In the example above Figure 12-8, set- 
ting the Start Time to 6 ns and then selecting the Pick option again will improve the 
picks. 

• If the pick percentage is still low, in the Automatic Pick Options dialog select a different 
Reference Pulse. The best strategy is to select a wavelet type and compare the way it 
picks the bottom of the ice reflector to the previously selected wavelet form. Use the 
option that correctly picks the bottom of the ice reflector consistently. 
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12.5.4 Editing Picks 

The blue line indicates the bottom of the ice (Figure 12-7). To correct any problems with 
individual traces: 

 

1) In the Automatic Pick pane, select the Edit Picks option. 

2) Move the mouse cursor cross-hair to the problem trace. 

To select a new pick time, move the cross-hair to a new time on the trace and then click 

the mouse. 

 
When manually editing picks, the old pick location temporarily turns red to reminds you that this 
is a pick location. Refreshing the screen will remove the temporary red marks. 
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12.5.5 Deleting Picks 
 

1) To delete a pick, in the IcePicker toolbar in the Automatic Pick pane, click the Edit Picks 

option. 

2) Move the mouse cursor cross-hair to the pick you want to delete. 

3) On your keyboard press Delete. 

The deleted picks will turn red. 

To delete more than one pick, press the Delete key and the picks on either side of the 

mouse cursor are deleted. 
 
 
 

 
Figure 12-9: A deleted pick is displayed by a red line. 
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12.6 Ice Thickness Data 

1) Once all traces are picked, to display a table of ice thicknesses, in the IcePicker toolbar 
click View > Ice Thickness Data. 

Alternatively, in the Ice Thickness pane click View. 

 
The data displayed in the Ice Thickness Data dialog includes position based on cumulative GPS 
Distance, Ice Thickness, GPS Position in Latitude/Longitude, Elevation, Time, Signal Amplitude 
and Quality of the ice thickness data. If the traces have a relatively low quality rating it could be 
caused by the data that was collected on grounded ice or soil. 

 
 

Figure 12-10: The picked data is displayed as a spreadsheet. 

Double-click in any row of the table to move the mouse cursor to that position in the data 

line. The corresponding position in the data image is highlighted by arrows. 

 
2) Compare displayed thicknesses with measured thicknesses at the Ice Cal positions. Ice 

Cal information is displayed in the Comment column (as shown above). If the thickness 
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is inaccurate in column labeled Ice T (m), adjust the Ice Cal value by clicking View > Ice 
Cal Setting (to learn more, see Section 12.4.1 Ice Calibrations). 

The column labeled Quality is represented by a number between 0 or 1 indicating the quality of 
the ice thickness value. Relatively low quality values should be suspect. 

When data is collected in Free Run mode (Section 6.1.3.1), the position column values represent 
cumulative GPS positions. The accuracy of these values will depend on the accuracy of the GPS 
used for data collection. 

If the data was collected in Odometer mode (Section 6.1.3.2), the position information will 
depend on the odometer calibration and possible slippage during data acquistion. 

 

12.6.1 Ice Thickness Statistics 

The ice thickness statistics for the line (minimum, maximum, and average thickness) are 
displayed in the top left corner. 

 

12.6.2 Modifying Ice Thickness File Outputs 

The Display Thickness Range pane at the top of the Ice Thickness Data dialog box enables you 
to modify the output. 

Ice thickness files are limited to 5000 lines. If your data file has more than 5000 traces, it is 
broken up into multiple sheets; the total number of sheets is indicated in the Ice Thickness Data 
dialog. 

To move between sheets, click Next and Previous. 

To move to a specific sheet, in the First Trace text box, enter the sheet number for a specific 
trace. 

 

12.6.2.1 Display Thickness Range 
 

1) If you only want to capture an Ice Thickness data file of ice thicknesses within a certain 

range, in the Display Ice Thickness Range pane, click Modify. 

2) In the Display Thickness Range dialog, uncheck the All option. 

3) Enter the Minimum and Maximum ice thickness to display in the Ice Thickness File. 
 

 

 

Setting the Maximum to a certain value is a powerful way of reporting positions thinner than ice 
thickness. For example, if the Maximum is set to 50 cm, only those locations where the ice is less 
than 50 cm are included in the report. 
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12.6.2.2 Summary Report 
 

1) In the Summary Report pane, click Copy to copy the Ice Thickness Data to the clipboard. 
 

2) Paste this information into another document, such as an Excel file (as shown in figure 
13-11). 

 

 

 
Figure 12-11: A Summary Report pasted an Excel spreadsheet. 
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12.7 Saving the Ice Thickness Data 

1) To save the ice thickness data to a file, In the select a file type, in the IcePicker toolbar, 
click under File > Preferences (section 13.4). 

2) In the Export Ice Thickness Options pane, select one of the following file types: 

• CSV (Comma Separate Values), suitable for opening in Excel (Figure 12-12). 

• QuickMap, to create an ice thickness map using the Troubleshooting (Chapter 14) 

• Text (.txt) 

3) To save your Ice Thickness file, In the IcePicker toolbar, click File > Save Ice Thickness 
File. 

Alternatively, in the Ice Thickness pane, click Save. 

 
Figure 12-12: An example of a spreadsheet created by IcePicker showing the picked ice thickness data based on the 

Ice Cal value. 
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12.8 Google Earth KMZ Files 

In addition to exporting data to QuickMap, CSV, and text files, IcePicker enables you to export 
KMZ files which can be opened in Google Earth. 

The KMZ files generated by IcePicker contain GPS information describing the path travelled 
during line collection. KMZ files also display the ice thickness information using a user-definable 
color map. 

 

12.9 Generating KMZ Files 

1) To export picked IceMap data to Google Earth, in the section 10, IcePicker Software 
menu bar, File > Preferences. 

 
 

• To export KMZ files that display ice thickness information, In the Export Ice Thickness 
Options pane, select the Create Google Earth KMZ option. 

• To automatically open new KMZ files in Google Earth, in the Export Ice Thickness 
Options pane, select the Launch Google Earth on Export option. 

2) Click OK. 
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12.10 KMZ Color Map 

Saving an ice thickness file with the Create Google Earth KMZ option enabled prompts the 
Google Earth KMZ Color Map dialog to open (Figure 12-13). This feature allows you to modify 
how ice thickness values are displayed in the color range. 

 

 

Figure 12-13: Color Map for Google Earth KMZ file. 

The Google Earth Color Map displays the range of Ice Thickness Range above the color bar 
and the Dynamic Color Range below the color bar. Entering new values in the Dynamic Color 
range boxes changes the color scale applied to the ice thickness data in Google Earth. 

 

12.10.1 Selecting a Dynamic Color Range 

 
IcePicker Default 

To match the minimum and maximum color scale options to the minimum and maximum ice 
thickness data set, click Default. The color scale displays minimum ice thickness in red on the 
left end of the color scale, and maximum ice thickness data as blue on the right. All the other ice 
thicknesses between the minimum and maximum values are displayed as colors within the red 
blue spectrum. 

Use this setting to view the full range of thickness in a line and/or locate thick or thin ice data in a 
single data set (Figure 12-14). However, this is not a good option for comparing multiple lines 
side-by-side as each will have a different ice thickness range. 
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Figure 12-14: Google Earth image of an ice line displaying colors in full range of ice thickness. 

 
 

Predefined Values 

Define the Color Map with a consistent set of minimum and maximum values (Figure 12-15) 
when you need to compare multiple data sets, such as lines collected in the same location over a 
period of time, or lines collected adjacent to each other during the same survey. 

Predefined minimum and maximum colors enable you to recognize patterns across large 
sections of ice since specific ice thicknesses will always be represented by the same color. 

 

 

Figure 12-15: KMZ Color Map range set to a predefined ice thickness range. 

Figure 12-15 shows two example data sets plotted with the same maximum and minimum 
values. It can be easily seen that the ice was thinner (yellow vs. blue) when the line on the left 
was collected. IcePicker remembers the range previously used to make this strategy easy to 
perform. 
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. 

 
Figure 12-16: Google Earth images comparing two data sets collected at the same location at different times of the 

season using the same color map range (50 – 100 cm). The ice line in the image 1 displays a thinner ice pattern than 
the line in image 2. 

 
 

User Defined Values 

The KMZ Color Map enables you to set your own minimum and maximum values; employ this 
strategy to highlight thin areas in a data set. Representing ice thicknesses above a defined 
threshold value and color makes it easier for you to identify thinner sections of ice. 

 

1) To create a two-color data set that splits ice thickness into above/below threshold colors, 

set the minimum and maximum color scale values to the same number (Figure Figure 12- 

17, Map 1). 

2) In the maximum value text box, enter the value that represents your thickness threshold 
(60 cm in this example). 

3) To highlight the variations in ice thickness below your threshold, in the minimum value 
textbox, enter the value that represents your minimum ice thickness for the data set (50 
cm, see Figure 12-17, Map 2). 

To see how user defined values are displayed in Google Earth, see Figure 12-17. 
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Figure 12-17: Google Earth image of an ice thickness line with the color scale set to a threshold value. Map 1 displays 
minimum and maximum threshold values. Map 2 displays minimum values set to 50 cm. 
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12.10.2 Google Earth Limitations 

Due to Google Earth limitations, ice thickness points cannot be closer than about 1.5 meters (5 
feet) and the maximum number of points in one KMZ file cannot exceed 5000. If either case is 
exceeded, points are grouped and displayed as single value. 

The IcePicker Google Earth (KMZ) files always display the minimum ice thicknesses. If the ice 
thickness data have been grouped, for safety reasons, the KMZ file will plot the thinnest point of 
the grouped ice thickness points. 

 

 

 
Figure 12-18: Clicking a point in Google Earth displays information about the point including GPS position and 

whether it has been averaged with other points. 

To determine whether ice thickness points have been grouped: 
 

1) Plot the KMZ file. 

2) Zoom in to locate and then click an individual point in the survey (Figure 12-18). 

A text box opens displaying details of the point you selected: 

• the number of data points grouped together to generate that Google Earth point 

• the maximum, minimum, and average ice thicknesses of all the points in the group 
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• If the point has not been grouped, the maximum, minimum, and average values will be 
the same 

To avoid grouping data points, separate IceMap lines longer than 7.5 km (4 mi 1100yds) into two 
or more KMZ files: 

 

1) In the IcePicker toolbar, in the Automatic Pick pane, click Opt, (options). 

2) In the GPS Distance pane, enter a Start and End range to save to the KMZ file. 

Example: 

You have a file contains 10,000 traces: 
 

1) In the Automatic Pick Options dialog (Figure 12-6), enter a Start range point of 1 and 

an End range point of 5000. 

2) Pick the data. 

3) Save the ice thickness data and Google Earth KMZ files. 

4) In the Automatic Pick Options dialog, select traces 5001 to 10,000, pick the data and 
then save a second Google Earth KMZ file. 

Google Earth enables you to display multiple KMZ files at the same time. 
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13 Troubleshooting 

IceMap is designed to minimize user problems; however, all electronic devices are subject to 
possible failure. Use the following solutions should you have an issue with your IceMap system. 

 

 

13.1 Power Supply Problem 

If you find that your system is trying to run a system is insufficient power, the system battery may 
be dead or have a low voltage. 

 

1) To check your battery level, in the System Settings Menu (Chapter 6), click the Status tab 
and check the battery level. 

 

 

 
a) If the level is below the yellow threshold, the battery needs to be recharged or 

replace. 

b) If the battery level is sufficient but the system still is not running, check that the light 

on the connector to the Noggin is on. If this light is off then there is a problem with the 

connection from the NIC to the Noggin. 
 

2) Check the battery cable from the NIC to the Noggin GPR Sensor. 

3) Check the battery voltage with a voltmeter. 
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Try to do this while the battery is still attached to the IceMap system to get a true measure 

of the voltage while under load (it will be necessary to open the battery case or belt bat- 

tery case and connect the voltmeter to the positive and negative battery terminals). 

 
If the battery has a low voltage or seems dead, try the system with another battery (if 

available), or give the battery a good 12-14 hour charge and try running the system again. 

 
c) If the battery does not charge up to 12 Volts or more, it should be replaced. 

 

4) IceMap batteries are fused to protect the system. 

a) Open the battery case and check that the 10 Amp fuse is OK. 

b) If necessary, replace it with one of the spare fuses available inside the battery case. 
 

c) The smaller belt batteries available for the SmartHandle systems are also fused. 

Remove the battery from padded casing and check the 5 Amp fuse. Replace the fuse 

if necessary. 
 

Note: Be cautious of attempting to power the IceMap system through a 12v power pot (like a car 
lighter). These kind of power connections can be temperamental; they can disconnect for a split 
second when hitting a bump, causing the system to shut down and loose data for the current line. 

 

 

13.2 Connection Problem 

If the system power supply is OK but the Noggin GPR Sensor does not respond there may be a 
communication failure between the NIC and the Noggin. 

If an error occurs, an error message will appear on the IceMap screen: 
 

1) Disconnect the power source to completely shut down the system. 

2) Make sure that cable connectors are protected from high tension (this is the most likely 
break point). 

3) Disconnect the cables and check for damage. 

a) Check for bent pins on the cable or on the 37 pin connection on the back of the NIC 
and carefully straighten them with needle-nosed pliers. 

b) Clean out any dirt, moisture, oil, etc. and reconnect, ensuring that all cable 
connections are tightly secured. 

 

c) Sometimes vibrations cause the cable connections to loosen just a bit and break 
contact and this can cause errors. 

 

4) Disconnecting cables and reconnecting them may provide a better contact and solve the 
problem. 

5) Power the system back on and try running the system again. 
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If the power supply and cable are OK, the problem is likely a failure of the Noggin GPR Sensor or 
the NIC. These components have no user-serviceable parts so it will have to be returned to 
Sensors & Software Inc. for inspection and possible repair (see Section 13.8). 

 

 

13.3 Computer Problem 

The computer should be handled with care. If the computer does not power up and boot up, there 
may be a problem with the CPU or the storage media. If this occurs, contact Sensors & Software 
Inc. 

 

13.4 WiFi Connection 

Connection issues may be caused by the amount of metal between the PC and the sled; 
Specifically the tow vehicle itself. If the tow vehicle has an external rear mounted cab or fuel tank 
you may need to change then the location of the PC, or use an external antenna improve 
communication between the computer and the Noggin sensor. 

 

 

13.5 Noggin Problem 

When the IceMap system is powered-up for data collection it runs through a system initialization 
sequence and a message will be displayed on the screen for a few seconds. 

An error message indicates an internal problem with the Noggin. If an error occurs, power the 
system down, check connections (see Section 13.2), power it up again, and retry data 
acquisition. 

If the error persists, contact Sensors & Software Inc. (see Section 13.8). 

 

13.6 Odometer Problem 

Ensure adequate power supply to GPS and Transmission Odometer. Make sure odometers are 
properly calibrated. 

 

13.7 Creating a Test Line for Data Quality 

One of the best ways of detecting problems with the GPR system is: 
 

1) Shortly after receiving the system and getting comfortable with its operation, collect a line 
of data at a convenient, easily accessible location. 

The line does not have to be too long but 10 meters is a good guide. This data line should 
be saved electronically and perhaps plotted out on paper and dated. 

 
2) Collect a test line every 6 months and, by reviewing the previous data, system problems 

can be detected early. If there is a suspected problem with the system, this test line could 
be collected and compared with earlier tests. 
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13.8 Contacting Sensors & Software Inc. 

If you develop problems with your IceMap system, contact your agent or Sensors & Software Inc. 

Sensors & Software Inc.’s hours of operation are 9:00 AM to 5:00 PM Eastern Standard Time, 
Monday to Friday. You can contact Sensors & Software Inc. at: 

Sensors & Software Inc. 
1040 Stacey Court 

Mississauga, Ontario 
Canada L4W 2X8  

Tel: (905) 624-8909 
Fax: (905) 624-9365 

E-mail: sales@sensoft.ca 
Website: http://www.sensoft.ca/ 

 

When contacting Sensors & Software Inc., please have the following information available: 

• Noggin and NIC Serial Numbers. This information is available under the System Set- 
tings > Status tab (see Section 6.3) 

 

 

 

• Version number of the Icemap data acquisition software. This is available under the 
Help > About menu (see Section 11.3) 

• The error number or message appearing 

• A brief description of when the error is happening and the operating conditions (temper- 
ature, humidity, sunshine, system, and survey setup, etc.) 

mailto:sales@sensoft.ca
http://www.sensoft.ca/
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14 Care and Maintenance 

14.1 Battery Care 

• IceMap systems use 12-volt sealed lead acid batteries. They are fused with a 10 Amp 
fuse to protect them from short circuit damage 

• The IceMap SmartTow contains an 18 Amp-hour battery. This battery unit should run 
the IceMap system for 6-8 hours before recharging is necessary. 

• If long days of data surveying are typical, is a best practice to carry a second battery 

• If batteries are maintained in a charged condition they will give long life and reliable ser- 
vice. Improper use and lack of maintenance will greatly reduce their life. 

• Sealed lead acid batteries should never be left in a discharged condition for any period 
of time. Charge the batteries as soon as possible after use 

• Charge batteries at room temperature whenever possible 

• The IceMap system contains a voltage monitoring circuit that will turn off the unit when 
the input voltage drops below 10.2 volts 

• If a battery has been deeply discharged or left in a discharged condition for some period 
of time it may not accept a charge immediately when connected to the charger (The fast 
charge LED will not light). If the fast charge light does not come on within six hours, the 
battery should be considered damaged and be discarded 

• Do not assume that a battery that is still charging after eight hours is nearing the end of 
its charge cycle. Typical charging time for an empty battery is 12-14 hours from start of 
fast charge 

• Ensure that the batteries are fully charged before storing. If practical, store the batteries 
in a cool place, 10oc (a refrigerator is ideal), but make sure the temperature is not likely 
to drop below -30oC or the electrolyte may freeze and possibly split the case 

 

 

14.2 Cable Care 

• The cable connectors, as well as the connectors on the Noggin, NIC, and PoE Box 
need to stay clean and free of dust and moisture. Use a brush or air spray to clean dust, 
lint, and other foreign particles from these connectors 

• When the system is not being used, make sure the connections are covered to prevent 
dust and moisture from collecting inside. If the connectors are exposed, cover them with 
some sort of dust cap. 

• Cables are designed to be as tough as practical 

• Careless use of cables, such as making them carry loads that they are not designed for 
can cause internal damage 

• Connectors are weak points in any system. With the use of this product in rough, dusty 
and outdoor environments, you can minimize potential down time by treating the cables 
and connectors with respect 
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3) Cables and connectors are not designed to suspend or tow or otherwise carry the weight 
of systems. They are part of the electronic circuit and should be treated accordingly. 
When not in use they should be placed in their storage box. 

 

 

14.3 Storage Cases 

Equipment that is transported and stored loosely is more susceptible to damage. All equipment 
should be stored in its shipping case or a storage box. Sensors & Software has shipping cases 
available as options. 

 

 

14.4 Spare Parts 

For customers working in remote areas, or if downtime in the field is unacceptable, consider 
buying spare parts such as extra cables, batteries, and chargers. 
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15 Case Studies 

This section shows some examples of IceMap data. 

 

15.1 Fresh Water Ice 
 

Figure 15-1: Typical data of ice over fresh water. 
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15.2 Grounded Ice on Sandbars 
 
 

 

Figure 15-2: Weak reflections in the data image may be caused by ice frozen to the bottom. 



101 

IceMap 15-Case Studies 
 

 

 

15.3 Grounded Shore Ice 
 

 

Figure 15-3: Weak reflections near shore are usually caused by ice frozen to the bottom. 
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15.4 Grounded Shore Ice with Wet Sediments 

 

 
Figure 15-4: Weak reflections near the shore are usually caused by ice frozen to the bottom. The deeper strong reflec- 

tion is the interface between frozen ground and wet ground. 
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15.5 Sea Ice 

 

Figure 15-5: Sea ice has different properties than fresh water ice. Sometimes, depending on the crystal orientation 
and age of the ice, it attenuates the GPR signal resulting in very weak reflections. Re-collecting the data with the GPR 

turned 90 degrees usually improves the strength of the ice bottom reflector (see Section 2.2). 
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Appendix A Special Considerations for Sea Ice 

A-1 Antenna Orientation 

Unlike fresh water ice, sea ice is anisotropic (of unequal physical properties along different axes) 

with respect to GPR signals. This means that GPR signals penetrate through the ice better when 

the GPR antennas are in one orientation than in other orientations. As a result, the ice/water 

interface may seem to fade in and out or sometimes may not be visible at all. 
 

Example: data displayed in Figure A-1 was collected with the antenna oriented in line with the 

direction of motion of survey line. With the antenna in this orientation, there is no evidence of the 

sea ice/water boundary. There appears to be a response around the 12.75 ns (about 1.0 m) 

position that could be misinterpreted as the sea ice/water interface since it is the strongest 

reflection evident in the data. However, based on drilling information, it is not the bottom of ice 

reflector and most likely a multiple of the snow/ice interface. 
 
 

 

Figure A-1 Sea ice profiling with the antenna oriented parallel to the survey line. Note that the sea ice/water inter- 

face, which should be around 1m, is not visible. 

 

Figure A-2 displays approximately the same data as Figure A-1, but data for this survey line was 

collected with the antenna rotated 90 degrees so that it was perpendicular to the direction of the 

survey line. The sea ice/water boundary is now clearly defined at around 17ns (about 1.01 m). 
 
 

 
Figure A-2 Sea ice profiling with the antenna rotated 90 degrees from the direction of the survey line (perpendicu- 

lar).The sea ice/water interface is now visible at about 1m of depth. 
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Figure A-1 shows that sea ice, when compared to typical freshwater ice, can return significantly 

more reflections in the data image. These reflections can be caused by the actual structure in the 

ice and snow/ice reflections and multiples. These extra reflections can easily be misinterpreted 

as the bottom of the ice. Drilling, at least initially, is necessary to confirm the actual ice thickness. 
 

To highlight how sea ice return extra reflections compare Figures A-3 and A-4. the results 

displayed in Figure A-3 were gathered with the antenna oriented in line with the direction of 

survey line. in this image the sea ice/water interface is clearly visible. 
 

In Figure A-4, the antenna was rotated 90 degrees so that it is oriented perpendicular to the 

direction of the survey line. While the sea ice/water boundary is still evident, it is much weaker 

than that observed in Figure A-3. Near the end of line in Figure A-4, the sea ice/water boundary 

response becomes much stronger, but in this case it was a result of the vehicle turning around 

rather than a reorientation of the preferred axis in the sea ice. 
 

 

 

Figure A-3 Sea ice profiling shows the sea ice/water interface with the antenna oriented in the same direction as the 

survey line (parallel). 

 

 

 

Figure A-4 Sea ice profiling shows the sea/ice interface with the antenna oriented 90 degrees to the survey line (per- 

pendicular). Notice that the sea ice/water interface is still visible but much weaker. 
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In the first 2000 traces, the sea ice/water reflection is evident until around the 1500m position. At 

approximately 1500m the position of the antenna was rotated 90 degrees. The lost signal 

instantly reappears on the next section. The reflection is again lost between 2000-2200m and 

2500-2750m but the antenna was not rotated. From position 3000m to 6860m, a strong response 

is observed for the sea ice/water interface. Around position 7064m, the vehicle made the 

transition from snow covered to a ploughed section. The tail end of the last section shows the 

transition moving off the ice onto land. 
 

 

 

Figure A-5 An 8000 meter long section to show how often it may be necessary to rotate the antenna. The total sec- 

tion is broken into 4 parts, each one approximately 2000 meters long 
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A-2 Signal Strength and Gain Settings 

As mentioned in the previous section, when collecting ice profiling data over sea ice, the signal 

strength (amplitude) is much smaller than that observed in freshwater ice data. Because of this, 

gain settings are crucial for displaying a good sea ice profiling image. 
 

Make sure that the Ice setting is set to Sea Ice. You may need to increase the Gain setting during 
data collection. 
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Appendix B Caching Google Earth Information 

 
B-1 Background 

GPR data from a variety of Sensors & Software GPR systems and software packages can be dis- 

played in Google Earth. When the PC is connected to the internet, Google Earth automatically 

updates surface images as users navigate around the Earth. When no internet connection is 

available, Google Earth can display surface images that have been previously viewed and saved 

(cached) into the PC memory. This allows GPR data to be viewed in Google Earth at anytime, 

anywhere in the world with no internet access required. 
 

The following procedure outlines how to cache Google Earth images on a field PC so GPR data 
images can be overlain on high resolution surface images when there is no internet connection. 

 

B-2 Google Earth Cache Settings 

1. Make sure that the PC is connected to the internet and that Google Earth ver- 

sion 6 (or higher) is installed. 
 

2. Launch Google Earth; select Tools – Options on the toolbar. Select the 

Cache tab. 
 
 
 

 
3. Verify that the Disk Cache Size (MB) is set to 2000. 
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4. Verify that the Memory Cache Size (MB) is set to the maximum value for the 

PC. 
 

To determine this, enter a value of 2000 and select Apply. Google Earth will automatically 

determine the maximum available Memory Cache for the PC, display a NOTICE MESSAGE 

and set the value. 

5. Click OK. 
 

6. Click OK to exit the Google Earth Options dialog box. 

 

B-3 Caching Google Earth Images 

Navigate in Google Earth to the GPR survey location. Make sure to zoom in on all potential sur- 

vey areas so the desired image resolution is achieved. Google Earth automatically saves the 

viewed images to the PC so that they are available when there is no internet connection. A max- 

imum of 2000 MB of images can be saved; once this limit is reached the oldest images are 

replaced with newer ones. 

 

B-4 Using Cached Google Earth Images 

When Google Earth is accessed with no internet connection available, a warning message is 

automatically displayed indicating that there is no connection. The message asks the user to per- 

form a diagnostic test to resolve the problem. Users should select No. Google Earth will launch 

normally and display only the images previously cached. 
 

 

 
When exiting Google Earth, a message appears asking if the user wants to save their GPR data 

into the “My Places” folder. If the user would like to retain the GPR data images for future refer- 

ence, select Save; otherwise select Discard to prevent the My Places folder from becoming clut- 

tered with numerous data images. Saved data resides in the Google Earth program. 
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Appendix C GPR Emissions, Interference and Regulations 

All governments have regulations on the level of electromagnetic emissions that an electronic 

apparatus can emit. The objective is to assure that one apparatus or device does not interfere 

with any other apparatus or device in such a way as to make the other apparatus non-functional. 
 

Sensors & Software Inc. extensively test their pulseEKKO, Noggin and Conquest subsurface 

imaging products using independent professional testing houses and comply with latest regula- 

tions of the USA, Canada, European Community, and other major jurisdictions on the matter of 

emissions. 
 

GPR instruments are considered to be UWB (ultra-wideband) devices. The regulatory regimes 

worldwide are devising new rules for UWB devices. Sensors & Software Inc. maintains close 

contact with the regulators to help guide standard development and assure that all products con- 

form. You should continually monitor the "News" link on our website (www.sensoft.ca) for updates 

on standards. 
 

Electronic devices have not always been designed for with immunity in mind. If a GPR instrument 

is placed in close proximity to an electronic device, interference may occur. While there have 

been no substantiated reports of interference to date, if any unusual behavior is observed on 

nearby devices, test if the disturbance starts and stops when the GPR instrument is turned on 

and off. If interference is confirmed, stop using the GPR. 
 

Refer to the following sections to learn about specific GPR guidelines in specific jurisdictions. 
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C-1 FCC Regulations (USA) 

This device complies with Part 15 of the USA Federal Communications Commission (FCC) 

Rules. Operation in the USA is subject to the following two conditions: 
 

1. this device may not cause harmful interference 

2. this device must accept any interference received, including interference that 
may cause undesired operation. 

 

Part 15 – User Information 

This equipment has been tested and found to comply with the limits for a Class A digital device, 

where applicable, and for an ultrawide bandwidth (UWB) device where applicable, pursuant to 

Part 15 of the FCC Rules. These limits are designed to provide reasonable protection against 

harmful interference when the equipment is operated in a commercial environment. This equip- 

ment generates, uses and can radiate radio frequency energy and, if not installed and used in 

accordance with the instruction manual, may cause harmful interference to radio communica- 

tions. Operation of this equipment in a residential area is likely to cause harmful interference in 

which case the user will be required to correct the interference at his own expense. 

 
WARNING 

Changes or Modifications not expressly approved by Sensors & Software Inc. could void the 
user’s authority to operate the equipment. 

 

Certification of this equipment has been carried out using approved cables and peripheral 

devices. The use of non-approved or modified cables and peripheral devices constitutes a 

Change or Modification outlined in the warning above. 

 
Operating Restrictions 

Operation of this device is limited to purposes associated with law enforcement, fire fighting, 
emergency rescue, scientific research, commercial mining, or construction. Parties operating this 
equipment must be eligible for licensing under the provisions of Part 90 of this chapter. 

 

FCC Interpretation of Operation Restrictions issued July 12, 2002 
(FCC Order DA02-1658, paragraph 9) 

The regulations contain restrictions on the parties that are eligible to operate imaging systems. 1 

Under the new regulations, GPRs and wall imaging systems may be used only by law enforce- 

ment, fire and emergency rescue organizations, by scientific research institutes, by commercial 

mining companies, and by construction companies. Since the adoption of the Order, we have 

received several inquiries from the operators of GPRs and wall imaging systems noting that 

these devices often are not operated by the users listed in the regulations but are operated under 

contract by personnel specifically trained in the operation of these devices. We do not believe 
 
 

1. See 47 C.F.R. §§15.509(b), 15.511(b), and 15.513(b) 
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that the recent adoption of the UWB rules should disrupt the critical safety services that can be 

performed effectively only through the use of GPRs and wall imaging systems. We viewed these 

operating restrictions in the broadest of terms. For example, we believe that the limitation on the 

use of GPRs and wall imaging systems by construction companies encompasses the inspection 

of buildings, roadways, bridges and runways even if the inspection finds no damage to the struc- 

ture and construction does not actually result from the inspection; the intended purpose of the 

operation of the UWB device is to determine if construction is required. We also believe that the 

GPRs and wall imaging systems may be operated for one of the purposes described in the regu- 

lations but need not be operated directly by one of the described parties. For example, a GPR 

may be operated by a private company investigating forensic evidence for a local police depart- 

ment. 

 
FCC Permitted Mode of Usage 

The GPR antenna must be kept on the surface to be in compliance with FCC regulations. Use of 

the antenna is not permitted if it is lifted off the surface. Use as a through-the-wall imaging device 

is prohibited. 

 
GPR Use Coordination 

FCC regulation 15.525(c) (updated in February 2007) requires users of GPR equipment to coor- 

dinate the use of their GPR equipment as described below: 
 

TITLE 47--TELECOMMUNICATION 
 

CHAPTER I--FEDERAL COMMUNICATIONS COMMISSION 

PART 15_RADIO FREQUENCY DEVICES 

Subpart F_Ultra-Wideband Operation Sec. 
 

15.525 Coordination requirements. 
 

(a) UWB imaging systems require coordination through the FCC before the equipment may be 
used. The operator shall comply with any constraints on equipment usage resulting from this 
coordination. 

 

(b) The users of UWB imaging devices shall supply operational areas to the FCC Office of 

Engineering and Technology, which shall coordinate this information with the Federal Govern- 

ment through the National Telecommunications and Information Administration. The information 

provided by the UWB operator shall include the name, address and other pertinent contact infor- 

mation of the user, the desired geographical area(s) of operation, and the FCC ID number and 

other nomenclature of the UWB device. If the imaging device is intended to be used for mobile 

applications, the geographical area(s) of operation may be the state(s) or county(ies) in which the 

equipment will be operated. The operator of an imaging system used for fixed operation shall 

supply a specific geographical location or the address at which the equipment will be operated. 

This material shall be submitted to: 
 

Frequency Coordination Branch, OET 
Federal Communications Commission 
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445 12th Street, SW, Washington, D.C. 

20554 
Attn: UWB Coordination 

 

(Sensors & Software Inc. Note: The form given on the following page is a suggested format for 

performing the coordination.) 
 

(c) The manufacturers, or their authorized sales agents, must inform purchasers and users of 

their systems of the requirement to undertake detailed coordination of operational areas with the 

FCC prior to the equipment being operated. 
 

(d) Users of authorized, coordinated UWB systems may transfer them to other qualified users 

and to different locations upon coordination of change of ownership or location to the FCC and 

coordination with existing authorized operations. 
 

(e) The FCC/NTIA coordination report shall identify those geographical areas within which the 

operation of an imaging system requires additional coordination or within which the operation of 

an imaging system is prohibited. If additional coordination is required for operation within specific 

geographical areas, a local coordination contact will be provided. Except for operation within 

these designated areas, once the information requested on the UWB imaging system is submit- 

ted to the FCC no additional coordination with the FCC is required provided the reported areas of 

operation do not change. If the area of operation changes, updated information shall be submit- 

ted to the FCC following the procedure in paragraph (b) of this section. 

(f) The coordination of routine UWB operations shall not take longer than 15 business days 

from the receipt of the coordination request by NTIA. Special temporary operations may be han- 

dled with an expedited turn-around time when circumstances warrant. The operation of UWB 

systems in emergency situations involving the safety of life or property may occur without coordi- 

nation provided a notification procedure, similar to that contained in Sec. 2.405(a) through (e) of 

this chapter, is followed by the UWB equipment user.[67 FR 34856, May 16, 2002, as amended 

at 68 FR 19751, Apr. 22, 2003] 
 

Effective Date Note: At 68 FR 19751, Apr. 22, 2003, Sec. 15.525 was amended by revising 

Page 925 paragraphs (b) and (e). This amendment contains information collection and record- 

keeping requirements and will not become effective until approval has been given by the Office of 

Management and Budget. 
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FCC GROUND PENETRATING RADAR COORDINATION NOTICE 
 
 

NAME: 

 

 
ADDRESS: 

 

 
CONTACT INFORMATION [CONTACT NAME AND PHONE NUMBER]: 

 

 
AREA OF OPERATION [COUNTIES, STATES OR LARGER AREAS]: 

 

 
FCC ID: [E.G. QJQ-NOGGIN100 FOR NOGGIN 100 SYSTEM, QJQ-NOGGIN250 FOR NOGGIN 250 

SYSTEM, QJQ-NOGGIN500 FOR NOGGIN 500 SYSTEM, QJQ-NOGGIN1000 FOR NOGGIN 1000 SYS- 

TEM] 

 

 
EQUIPMENT NOMENCLATURE: [E.G. NOGGIN 250] 

 
 
 
 

Send the information to: 
 

Frequency Coordination Branch., OET 

Federal Communications Commission 

445 12th Street, SW 

Washington, D.C. 20554 

ATTN: UWB Coordination 

Fax: 202-418-1944 

 
 
 
 
 
 
 
 
 
 
 
 
 

INFORMATION PROVIDED IS DEEMED CONFIDENTIAL 
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C-2 ETSI Regulations for the EC (European Community) 

In the European Community (EC), GPR instruments must conform to ETSI (European Technical 

Standards Institute) standard EN 302 066-1 v1.2.1. Details on individual country requirements for 

licensing are coordinated with this standard. For more information, contact Sensors & Software’s 

technical staff. 
 

All Sensors & Software ground penetrating radar (GPR) products offered for sale in European 

Community countries or countries adhering to ETSI standards are tested to comply with EN 302 

066 v1.2.1. 
 

For those who wish to get more detailed information, they should acquire copies of the following 
documents available from ETSI. 

 

ETSI EN 302 066-1 V1.2.1 (February 2008) Electromagnetic compatibility and Radio spectrum 

Matters (ERM); Ground and Wall- Probing Radar applications (GPR/WPR) imaging systems; 

Part 1: Technical characteristics and test methods 
 

ETSI EN 302 066-2 V1.2.1 (February 2008) Electromagnetic compatibility and Radio spectrum 

Matters (ERM); Ground and Wall- Probing Radar applications (GPR/WPR) imaging systems; 

Part 2: Harmonized EN covering essential requirements of article 3.2 of the R&TTE Directive 
 

ETSI TR 101 994-2 V1.1.2 (March 2008) Electromagnetic compatibility and Radio spectrum Mat- 

ters (ERM); Short Range Devices (SRD); Technical characteristics for SRD equipment using 

Ultra Wide Band technology (UWB); Part 2: Ground- and Wall- Probing Radar applications; Sys- 

tem Reference Document 
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C-3 Industry Canada Regulations - English 

Industry Canada published it regulations for ground penetrating radar (GPR) on Mar 29 2009 as 

part of the RSS-220 titled 'Devices Using Ultra-Wideband (UWB) Technology'. 
 

Industry Canada has made a unique exception for GPR by not requiring user licensing. The user 
does have to comply with the following directives: 

 

(1) This Ground Penetrating Radar Device shall be operated only when in contact with or within 
1 m of the ground. 

2. This Ground Penetrating Radar Device shall be operated only by law enforce- 
ment agencies, scientific research institutes, commercial mining companies, 
construction companies, and emergency rescue or fire fighting organizations. 

 

Should the ground penetrating radar be used in a wall-penetrating mode then the following 

restriction should be noted by the user: 
 

(1) This In-wall Radar Imaging Device shall be operated where the device is directed at the wall 

and in contact with or within 20 cm of the wall surface. 

2. This In-wall Radar Imaging Device shall be operated only by law enforcement 

agencies, scientific research institutes, commercial mining companies, con- 

struction companies, and emergency rescue or fire fighting organizations. 
 

Since operation of GPR is on a licence-exempt basis, the user must accept the following: 
 

Operation is subject to the following two conditions: (1) this device may not cause interference, 

and (2) this device must accept any interference, including interference that may cause undes- 

ired operation of the device. 
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C-4 Règlement d'Industrie Canada - Français 

Industrie Canada a publié des règlements pour les appareils géoradar (GPR) le 29 mars 2009, 

dans le cadre du RSS-220 intitulé "Dispositifs utilisant la bande ultra-large (UWB)". 
 

Industrie Canada a faite une exception unique pour GPR en n'exigeant pas de licence par utili- 
sateur. L'utilisateur doit se conformer aux directives suivantes: 

 

(1) Ce géoradar périphérique doit être utilisé que lorsqu'il est en contact avec ou moins de 1 m 
du sol. 

2. Ce géoradar périphérique doit être utilisé que par les organisations d'applica- 

tion de la loi, les instituts de recherche scientifique, des sociétés minières 

commerciales, entreprises de construction et de secours d'urgence ou des 

organisations de lutte contre les incendies. 
 

Si le géoradar est utilisé dans un mode de pénétration au mur, la restriction suivante est à noter 
par l'utilisateur: 

 

(1) Ce dispositif d'imagerie radar doit être utilisé lorsque l'appareil est orienté vers le mur et en 
contact avec ou dans les 20 cm de la surface du mur. 

2. Ce dispositif d'imagerie radar doit être utilisé que par les organisations d'appli- 

cation de la loi, les instituts de recherche scientifique, des sociétés minières 

commerciales, entreprises de construction et de secours d'urgence ou des 

organisations de lutte contre les incendies. 
 

Parce que l'exploitation de GPR est sur une base exempte de licence, l'utilisateur doit accepter le 
texte suivant: 

 

La fonctionnement est soumis aux deux conditions suivantes: (1) cet appareil ne peut pas provo- 

quer d'interférences et (2) cet appareil doit accepter toute interférence, y compris les inter- 

férences qui peuvent causer un mauvais fonctionnement du dispositif. 
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Appendix D Instrument Interference 

Immunity regulations place the onus on instrument/apparatus/device manufacturers to assure 

that extraneous interference will not unduly cause an instrument/apparatus/device to stop func- 

tioning or to function in a faulty manner. 
 

Based on independent testing house measurements, Sensors & Software Inc. systems comply 

with regulations in Canada, USA, European Community, and most other jurisdictions. GPR 

devices can sense electromagnetic fields; external sources of electromagnetic fields, such as TV 

stations, radio stations, and cell phones, can cause signals detectable by a GPR which may 

degrade the quality of the data that a GPR device records and displays. 
 

Such interference is unavoidable, but sensible survey practice and operation by an experienced 

GPR practitioner can minimize such problems. In some geographic areas emissions from exter- 

nal sources may be so large as to preclude useful measurements. Such conditions are readily 

recognized and accepted by the professional geophysical community as a fundamental limitation 

of geophysical survey practice. This type of interference present in GPR recordings is not consid- 

ered as an equipment fault or as a failure to comply with immunity regulations. 
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Appendix E Safety Around Explosive Devices 

Concerns have been expressed regarding the hazard of GPR products being used near blasting 

caps and Unexploded Ordnance (UXO). Experience with blasting caps indicates that the power 

of Sensors & Software Inc.’s GPR products is not sufficient to trigger blasting caps. Based on a 

conservative independent testing house analysis, it is considered a precautionary best practice 

to keep the GPR transmitters at least 5 feet (2m) away from blasting caps. 
 

Some customers carry out experimental trials with their blasting devices to conform to safety reg- 
ulations. Sensors & Software recommends that GPR users routinely working with explosive 
devices to develop a systematic safety methodology in their work areas. 

 

The UXO issue is more complex, and standards on fuses do not exist for obvious reasons. To 

date, no problems have been reported with any geophysical instrument used for UXOs. Since 

proximity and vibration are also critical for UXO, the best advice is to be cautious and understand 

the risks. 



E-2 

Appendix E: Safety Around Explosive Devices IceMap 
 

 

 



IceMap Appendix F: Health & Safety Certification 

F-1 

 

 

 

Appendix F Health & Safety Certification 

Strong radio frequency Electromagnetic (EM) Fields may pose a health hazard. Normal EM fields 

have been studied extensively over the past 30 years with no conclusive epidemiology relating 

EM fields to health problems. Detailed discussions on the subject are contained in the references 

and the web sites listed below. 

The USA Federal Communication Commission (FCC) and Occupational Safety and Health 

Administration (OSHA) both specify acceptable levels for electromagnetic fields. Similar power 

levels are mandated by corresponding agencies in other countries. Maximum permissible expo- 

sures and time duration specified by the FCC and OSHA vary with excitation frequency. The low- 

est threshold plane wave equivalent power cited is 0.2 mW/cm2 for general population over the 

30 to 300 MHz frequency band. All other applications and frequencies have higher tolerances as 

shown in graphically in Figure B-1. 
 

 

 
Figure F-1: FCC limits for maximum permissible exposure (MPE) plane-wave equivalent power density mW/cm2. 

 

All Sensors & Software Inc. pulseEKKO, Noggin, and Conquest products are normally operated 

at least 1 m from the user and as such are classified as mobile devices according to the FCC. 

Typical power density levels at a distance of 1 m or greater from any Sensors & Software Inc. 

product are less than 10-3 mW/cm2 which is 200 to 10,000 times lower than mandated limits. As 

such, Sensors & Software Inc. products pose no health and safety risk when operated in the nor- 

mal manner of intended use. 
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References 

1. Questions and answers about biological effects and potential hazards of radio-frequency 
electromagnetic field. 

USA Federal Communications Commission, Office of Engineering & Technology 

OET Bulletin 56 

(Contains many references and web sites) 

 
2. Evaluation Compliance with FCC Guidelines for Human Exposure to Radio Frequency Elec- 

tromagnetic Fields. 

USA Federal Communications Commission, Office of Engineering & Technology 

OET Bulletin 56 

(Contains many references and web sites) 

 
3. USA Occupational Safety and Health Administration regulations paragraph 1910.67 and 

1910.263. 

 

Web Sites 

www.fcc.gov/Bureau/EngineeringTechnology/Documents/bulletin 

www.osha-slc.gov/SLTC (see radio frequency) 

http://www.fcc.gov/Bureau/EngineeringTechnology/Documents/bulletin
http://www.osha-slc.gov/SLTC
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